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About This Manual

The Aspen Plus User Guide consists of three volumes that provide step-by-step
instructions for using Aspen Plus® to build and use a process simulation model.

Volume 1 describes the Aspen Plus user interface and explains how to perform
the basic tasks for creating and running simulations. Topics include:

Creating a simulation model

Defining the flowsheet

Entering the required information, such as components, streams and physical
property data

Running the simulation

Examining results

Volume 2 contains procedures for using additional Aspen Plus capabilities:

Convergence
Sensitivity

Design specifications
Optimization
Property analysis
Data regression

Volume 3 contains information about:;

Aspen Plus User Guide
Version 10.1-0

Pressure relief calculations

Stream libraries

Working with other Windows™ programs

The Aspen Plus ActiveX® automation interface
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For More Information

Online Help Aspen Plus has a complete system of online help and
context-sensitive prompts. The help system contains both context-sensitive help
and reference information. For more information about using Aspen Plus help, see
the Aspen Plus User Guide, Chapter 3.

Aspen Plus Getting Started Building and Running a Process Model This
tutorial includes several hands-on sessions to familiarize you with Aspen Plus.
The guide takes you step-by-step to learn the full power and scope of Aspen Plus.

Aspen Plus Getting Started Modeling Processes with Electrolytes This
tutorial includes several hands-on sessions to familiarize you with simulating
electrolyte systems with Aspen Plus.

Aspen Plus Getting Started Modeling Petroleum Processes This tutorial
includes several hands-on sessions to familiarize you with simulating petroleum
processes with Aspen Plus.

Aspen Plus Getting Started Customizing Unit Operation Models This
tutorial includes several hands-on sessions to familiarize you with the
customization of unit operation models with Aspen Plus.

Aspen Plus User Guide The three-volume Aspen Plus User Guide provides
step-by-step procedures for developing and using an Aspen Plus process
simulation model. The guide is task-oriented to help you accomplish the
engineering work you need to do, using the powerful capabilities of Aspen Plus.

Aspen Plus reference manual series Aspen Plus reference manuals provide
detailed technical reference information. These manuals include background
information about the unit operation models and the physical properties methods
and models available in Aspen Plus, tables of Aspen Plus databank parameters,
group contribution method functional groups, and a wide range of other reference
information. The set comprises:

e Unit Operation Models

e Physical Property Methods and Models
e Physical Property Data

* User Models

¢ System Management

e System Administration

¢ Summary File Toolkit

Aspen Plus application examples A suite of sample online Aspen Plus
simulations illustrating specific processes is delivered with Aspen Plus.

viii Aspen Plus User Guide
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Aspen Plus Installation Guides These guides provide instructions on
platform and network installation of Aspen Plus. The set comprises:

e Aspen Plus Installation Guide for Windows
e Aspen Plus Installation Guide for OpenVMS
e Aspen Plus Installation Guide for UNIX

The Aspen Plus manuals are delivered in Adobe portable document format (PDF)
on the Aspen Plus Documentation CD.

Technical Support

World Wide Web For additional information about AspenTech products and
services, check the AspenTech World Wide Web home page on the Internet at:

http://www.aspentech.com/

Technical resources To obtain in-depth technical support information on the
Internet, visit the Technical Support homepage. Register at:

http://www.aspentech.com/ts/

Approximately three days after registering, you will receive a confirmation e-mail
and you will then be able to access this information.

The most current Hotline contact information is listed. Other information
includes:

* Frequently asked questions
e Product training courses
e Technical tips

Aspen Plus User Guide iX
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AspenTech Hotline If you need help from an AspenTech Customer Support
engineer, contact our Hotline for any of the following locations:
If you are located in: Phone Number Fax Number E-Mail Address
North America & the +1-617/949-1021 +1-617/949-1724 support@aspentech.com
Caribbean +1-888/996-7001
(toll free)
South America
(Argentina office) +54-11/4393-5308 +54-11/4394-8621 tecnoba@aspentech.com
(Brazil office) +55-11/5506-0756 +55-11/5506-0567 tecnosp@aspentech.com
Europe, Gulf Region, & Africa atesupport@aspentech.com
(Brussels office) +32-2/724-0100 +32-2/705-4034
(UK office) +44-1223/312220 +44-1223/366980
Japan +81-3/3262-1743 +81-3/3262-1744 atjsupport@aspentech.com
Asia & Australia atasupport@aspentech.com
(Hong Kong office) +85-2/2838-6077 +85-2/2833-5642
(Korea office) +82-2/761-5800 +82-2/761-5803
Aspen Plus User Guide
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33

Pressure Relief
Calculations

This chapter describes how to use the Pressure Relief (Pres-Relief) features of
Aspen Plus to:

» Determine the steady-state flow rating of pressure relief systems
« Dynamically model vessels undergoing pressure relief due to a fire or heat
input specified by the user.

Topics in this chapter include:

* About pressure relief calculations

» Setting-up pressure relief calculations

» Specifying information for the scenarios

e Specifying the composition and conditions

« Defining the venting system

e Specifying chemical reactions

* Specifying when to stop the simulation (stop criteria)

e Specifying the over pressure factor and piping pressure drop rules
« Examining calculation results

Aspen Plus User Guide
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About Pressure Relief Calculations

Use Pressure Relief to simulate a vessel undergoing pressure relief or for simple
valve rating. Pressure Relief uses the same physical property models and data as
other Aspen Plus flowsheet models.

The modeling equations for nozzle flow, and for bubbly and churn-turbulent
disengagement are based on technology developed by the Design Institute for
Emergency Relief System (DIERS) Users Group of the AIChE. This technology is
considered the best available for pressure relief system design. The Aspen Plus
Pipeline model simulates flow through the inlet and tail pipes in the relief
system.

Pressure Relief always operates in rating mode. This means that the program
will calculate the pressure profile in the vessel and piping, given the size of the
relief device. In addition, you must specify the:

» Dimensions of the equipment being protected and a connecting nozzle if
present

* Pressure relief scenario

« Dimensions of inlet and tail piping, if present

« Dimensions of the relief device

Each Pressure Relief block models one scenario and one vessel. To model more
than one scenario or pressurized vessel in an Aspen Plus run, include more than
one Pressure Relief block in the simulation. Pressure Relief blocks are not part of
the simulation flowsheet (there is no icon needed), but they can reference
simulation streams.

Pressure Relief analyzes the specified scenario and reports:

* Rated capacity

* Results profiles (temperature, pressure, vapor fraction)

* Whether the system meets design rules that you select or that applicable
codes (such as ASME) require

Creating a Pressure Relief Block

To create a Pressure Relief block:
1. From the Data menu, point to Flowsheeting Options, then Pres-Relief.

2. In the Pressure Relief Object Manager, click New.

3. In the Create New ID dialog box, enter an ID (name) or accept the default
1D.

33-2 Aspen Plus User Guide
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4. Click OK.

The Pressure Relief Setup form appears.

See the remaining sections of this chapter for information on completing the
Pressure Relief specifications.

About Pressure Relief Scenarios

A Pressure Relief scenario is a situation that causes venting to occur through the
relief system. There are four types of generic scenarios to choose from:

» Steady-state flow rating of relief system (valve and piping)
» Steady-state flow rating of relief valve (no piping)

e Dynamic run with vessel engulfed by fire

* Dynamic run with specified heat flux into vessel

Each scenario is described briefly below.

Steady-State Flow Rating of Relief System Scenario

Use this scenario to find the flow rate through an emergency relief system, given
the condition of the stream flowing into it and the upstream and downstream
pressures. The relief system may include a relief valve a vessel neck, and two
segments each, of inlet and tail pipes, as well as any number of block valves and
fittings. In this scenario the pressure relief model calculates the steady-state flow
rate through the specified system.

Steady-State Flow Rating of Relief Valve Scenario

Use the valve rating scenario when:

* You know the pressure, temperature, and stream composition
* You want to find out the valve capacity

The differences between the Valve rating scenario and the Relief System Rating

scenario are that in the Valve Rating scenario:

* No piping is allowed

» The relief device must be a Process Safety Valve (PSV) or a Process Safety
Valve-Process Safety Disk (PSV-PSD)

Aspen Plus User Guide 33-3
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Dynamic Run With Vessel Engulfed by Fire Scenario

Pressure Relief provides three standards for computing the fire exposure
scenario:

* NFPA 30
* API 520
* API 2000

The chosen fire standard determines which regulations are used to calculate fire
scenario factors such as vessel wetted area, energy input, and credit factors.

Pressure Relief assumes the calculated energy input is constant during the entire
venting transient. If appropriate, you can specify individual credit factors for
drainage, water spray, and insulation to reduce the energy input. Alternatively,
you can specify an overall credit factor.

Dynamic Run With Specified Heat Flux Into Vessel
Scenario

The heat input scenario is similar to the fire exposure scenario, except:

* You choose the energy input value
» Credit factors are not allowed

There is no cut-off time for the duration of the event. The specified heat flux can
be constant, from a constant temperature source, or a function of time.

This scenario can be used to model:

» Full-on electrical heaters or other constant energy sources, by selecting the
Constant Duty heat input method.

* Pressure relief caused by runaway reactions, by using the Constant Duty heat
input method and specifying a value of zero for heat duty.

» Heat input from a source such as heat exchanged by selecting the Calculated
from the Heat Source method and providing a source temperature, a heat
transfer coefficient and surface area.

Aspen Plus User Guide
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Selecting a Pressure Relief Scenario

To specify a pressure relief scenario:

1. On the Pressure Relief Setup Scenario sheet, click one of the four choices of
pressure relief scenario.

G'Sc:enarinl"-ii' Streaml Yeszel Cantents |G'Hules| Flash Optians | FEz | hl

— Prezzure relief scenarnio
% Steady state flow rating of relief system

" Steady state flow rating of relief valve
" Diynarnic mn with vessel engulfed by fie

" Dwnamic run with specified heat ux into vessel

— Specifications

Capacity option; Code *I
Yent dizcharge pressure: bar j
E ztirnated flow rate: IMD|E j kol ki j

2. From the Capacity option list, select Code or Actual.

Choose this option To run the Meaning This option is useful for
simulation at

Code (default) Code capacity De-rates capacity of relief device Determining if a pressure relief valve or
as specified by ASME code rupture disk of a given size is adequate
requirements. for the chosen scenario.

Actual Actual capacity ~ Produces best estimate of relief Checking whether the inlet or tail pipe
system effluent. Does not de-rate sections meet the code compliant
capacity. requirements.

3. Specify the Vent Discharge Pressure. You need to specify this for all pressure
relief scenarios. If there are any tail pipe segments after the relief device the
discharge pressure refers to the pressure at the end of piping. This is
typically the atmospheric pressure of the flare header back pressure.

4. If you selected a steady state flow scenario, enter the Estimated Flow Rate.

The value you enter is used as a starting point to determine the rated flow for
the relief system or safety valve. You can enter this flow in a mass, mole or
standard liquid volume basis.

Aspen Plus User Guide 33-5
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The scenario you choose on the Setup Scenario sheet determines which of the
remaining Pressure Relief forms and sheets you need to complete to define your
system. The required forms will be displayed as incomplete in the left pane of the
Data Browser Forms and sheets that do not apply to your chosen scenario are

inactive.

Use Next to guide you through the required forms.

Specifying the Inlet Stream for Steady State Scenarios

For the steady state scenarios of relief valve or relief system rating you must
provide the composition of the stream entering the relief valve or system.

— Reference stream

[ Feference stream composzition

— Stream compozition

Baszis: I M ole-fraction j
I J Egmpgnent Frachan
™| Eeference shieam temperatune HZ0
:: Beterence shiean pressume HETHANGL
= i frach
eference sean vaparn Machion FEAED
— Uzer flazh zpecifications MCACET
Temperature: C j
Freszure: bar j
Yap. fraction: j
You can:
» Specify the composition of a stream or vessel by referencing a stream from the
flowsheet

» Specify the stream composition directly in the pressure relief block

These specifications are entered on the Stream sheet of the Pressure Relief Setup

form.

To specify the composition of a stream or vessel by referencing a stream from the

flowsheet:

1. Select the Stream tab from the Pressure Relief Setup form.

33-6
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2. On the Stream sheet, click the Reference Stream Composition check box.

3. In the field below the check box, select the desired stream.

To specify the stream composition directly in the pressure relief block:

1. Select the Stream tab from the Pressure Relief Setup form, to open that
sheet.

2. In the Stream Composition frame of the Stream sheet, choose a composition
basis from the Basis list.

3. Enter the component fractions in the Fraction fields next to each component
present in the stream.

In addition to the composition, you must specify the thermodynamic conditions of
the inlet stream. This involves specifying some combination of the three state
variables: temperature, pressure, and molar vapor fraction. These values can
either be entered directly on the Stream sheet, or referenced from the flowsheet
if you have referenced a stream composition.

To reference an inlet stream state variable from a flowsheet stream:

1. On the Stream sheet, first ensure that you have checked the Reference
Stream Composition check box. You cannot reference state variables from a
stream if you have not also referenced the composition.

2. In the Reference Stream frame of the Stream sheet, click the check box
indicating which stream variable you wish to reference:

» Reference Stream Temperature
» Reference Stream Pressure
» Reference Stream Vapor Fraction

To specify a state variable for the inlet stream directly in the pressure relief
block:

1. On the Stream sheet, enter a value in one of the fields of the User Flash
Specifications frame:

 Temperature
* Pressure
* Vap. Fraction
2. Select the appropriate units for the entered value.

If you wish, you can reference one state variable, and enter the other directly.

Aspen Plus User Guide 33-7
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Specifying Initial Vessel Contents for Dynamic
Scenarios

For the dynamic scenarios of fire or heat input, you must provide the initial
conditions of the vessel on the Vessel Contents sheet of the Pressure Relief Setup
form.

G’Scenariul Shean wWessel EuntentsliiHulesl Flash Options | Fiez 4 I PI

— Reference stream —%eszel filage

[T Reference steam compositiore Fillage: I
I j Fad gas Iﬁ
component:

™| Beferenee. shieam temperatune

™| Beference stream pressure —Wessel composition
™| Beferenee. sheam wapor frachion B asiz: IMnIe-fractiDn j
— Uszer flazh specifications—————— Component | Fraction
Temperature: C j H20
Pressure: bar j METHAMOL
Yap. fraction: j CAACID
MCACET

The initial conditions of the vessel can be specified in terms of:

» Composition

* Thermodynamic conditions (temperature, pressure or vapor fraction)

* Fillage

e Pad gas component

The composition of the vessel must be specified for all pressure relief blocks,

however the remaining specification can be specified using one of the following
three combinations:

e Two of temperature, pressure, and molar vapor fraction
» Two of temperature, pressure, and fillage
e All of temperature, pressure, fillage, and pad gas component

The pressure relief model uses this information and the volume you define on the
Pressure Relief ReliefDevice form to calculate the initial mass in the system.

Specifying Vessel Composition for Dynamic Scenarios

The vessel composition can be provided by either:

» Referencing a flowsheet stream composition
» Specifying values directly on the Vessel Contents sheet

33-8 Aspen Plus User Guide
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To specify the composition of the vessel by referencing a stream from the
flowsheet:

1. Select the Vessel Contents tab from the Pressure Relief Setup form.

2. On the Vessel Contents sheet, click the Reference Stream Composition check
box.

3. In the field below the check box, select the desired stream ID.

To specify the stream composition directly in the pressure relief block:
1. Select the Vessel Contents tab from the Pressure Relief Setup form.

2. In the Vessel Composition frame of the Vessel Contents sheet, choose a
composition basis from the Basis list.

3. Enter the component fractions in the Fraction fields next to each component
present in the vessel.

Defining Thermodynamic Conditions for Dynamic
Scenarios

To define the thermodynamic conditions, you must specify some combination of
the state variables temperature, pressure, or vapor fraction. The required
combination depends on whether you specify fillage and pad gas component.

When specifying temperature, pressure, and molar vapor fraction, you can either:

» Enter a value directly on the Vessel Contents sheet
+ Reference a flowsheet stream from which to retrieve the value

To reference a vessel state variable from a flowsheet stream:

1. On the Vessel Contents sheet, first ensure that you have checked the
Reference Stream Composition check box. You cannot reference state
variables from a stream if you have not also referenced the composition.

2. In the Reference Stream frame of the Vessel Contents sheet, click the check
box indicating which stream variable you wish to reference:

» Reference Stream Temperature
* Reference Stream Pressure
» Reference Stream Vapor Fraction

To specify a state variable for the vessel directly on the Vessel Contents sheet:

1. On the Vessel Contents sheet, enter a value in one of the fields of the User
Flash Specifications frame:

e Temperature
* Pressure
* Vap. Fraction
2. Select the appropriate units for the entered value.

Aspen Plus User Guide 33-9
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If you wish, you can reference one state variable, and enter another directly.

Fillage

Fillage is the initial fraction of the vessel volume filled with liquid (liquid
holdup). The fillage must be greater than zero and less than 0.994.

If you specify the fillage but not a pad-gas component, the temperature or
pressure specification will be used to determine the bubble point (vapor pressure
for pure components) of the initial mass.

To specify fillage:
0 On the Vessel Contents sheet, enter a value in the Fillage field of the Vessel
Fillage frame.

Pad Gas Component

Pad Gas Component represents the component being added to bring the pressure
up to the specified level. For example, nitrogen is often used as a pad gas in
hydrocarbon storage tanks.

To specify a pad gas component:

O On the Vessel Contents sheet, choose a component from the Pad Gas
Component list in the Vessel Fillage frame.

Design Rules

Use the Rules sheet of the Pressure Relief Setup form to specify rules regarding:

* Maximum vessel pressure (dynamic scenarios only)
* Inlet pipe pressure loss

» Tail pipe pressure loss

« Valve differential set pressure

33-10 Aspen Plus User Guide
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...................... ey

G’Scenarinl Shream |ii"»-"essel Contentz '{ii'Hulesgl Flazh Options | FEEE*II bI

— M asimum veszel pressure
* Percent of MAWF:

" Uszer specified: I b j

—Inlet pipe pressure loss

b airnum logz [percent]: |3

— T all pipe preszure logs
= Usze 97% rule

" Mazimumn loss [percent]: I

= Do not medel tail pipe pressure loss

—%alve differential zet prezsure

[ Differential set pressure changes as back pressure changes

Except for the limit on maximum vessel pressure, these rules apply only when
the relief device is selected to be a PSV (safety relief valve) or PSV in
combination with a PSD (rupture disk) for gas or two-phase service.

These rules have been included as an aid for good design practice. Pressure Relief
will generate warnings if any of the rules are violated. However, any design or
safety analysis decision involving these rules should be based on your own
interpretation of the relevant codes and design practices.

Each section of the Rules sheet is summarized below. See Aspen Plus Unit
Operation Models for a detailed discussion of design rules.

The following table summarizes the application of the design rules:

Rule Application Device

Inlet pressure loss At 10% over-pressureJr Gas/2 phase service PSV
Tail pressure loss At 10% over-pressureJrT Gas/2 phase service PSV
97% rule At or above 10% over-pressureJr Gas/2 phase service PSV
Max vessel pressure Always All devices

t If 10% over-pressure is not reached, the highest pressures are scaled to 10% over-pressure. If all

pressures are above 10% over-pressure, these rules are not applied and a warning is issued.
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Maximum Vessel Pressure

For the dynamic scenarios of fire or heat input, you must provide the maximum
vessel pressure. This value can be expressed as an absolute value in the User
Specified field, or as a percentage of the maximum allowable working pressure
(MAWP) entered on the Design Parameters sheet of the Pressure Relief
Dynamiclnput form.

When using the Percent of MAWP specification, MAWP is converted to gauge
pressure before Aspen Plus applies the percentage entered.

Inlet Pipe Pressure Loss

Use this field to enter the maximum inlet piping pressure loss as a percentage of
differential set pressure. This is calculated at 10% over-pressure or maximum
pressure if 10% over-pressure is not reached. Aspen Plus generates a warning if
the total pressure loss in the inlet piping is greater than or equal to the specified
percentage of differential set pressure. The specified value is usually 3 (the
default), and this rule is often called the “3% rule.”

Tail Pipe Pressure Loss

Use this frame for specifying the method for setting the allowable tail pipe
pressure loss. You can do one of the following:

* Use the 97% Rule

» Enter the maximum loss expressed as a percentage of differential set
pressure (known as the X% Rule)

» Specify that Pressure Relief not model tail pipe pressure loss

When the 97% rule is used, Aspen Plus generates a warning if the valve pressure
drop is less than 97% of the valve's differential set pressure. When the X% rule is
used, Aspen Plus generates a warning if the pressure loss after the valve is equal
to or greater than X% of the valve differential set pressure.

The following tables suggests which rule should be used for the most common
types of safety valves:

Valve Type Suggested Tail Piping Rule
Standard spring loaded 97% Rule or X% with X=10
Pop action pilot with unbalanced pilot vented to discharge 97% Rule or X% with X=10
Balanced bellows spring loaded X% with X=30

Modulating pilot with balanced pilots or pilots vented to X% with X=40

atmosphere
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Valve Differential Set Pressure

You can specify whether the differential set pressure (DSP), changes when back
pressure changes (that is, whether the valve is balanced or vented).

The following tables indicates whether the DSP changes for the most common
types of safety valves:

Valve Type Does DSP change?
Standard spring loaded Yes

Pop action pilot with unbalanced pilot vented to discharge Yes

Balanced bellows spring loaded No

Modulating pilot with balanced pilots or pilots vented to No

atmosphere

Specifying the Venting System

Aspen Plus User Guide
Version 10.1-0

A Pressure Relief venting system can consist of the following components:

» A vessel neck (nozzle)

» Up to two lengths (segments) of inlet pipe connecting the vessel neck to the
pressure relief device

» The pressure relief device (safety valve, rupture disk, relief vent, or
combination rupture disk and safety valve)

» Up to two lengths (segments) of tail pipe from the relief device to the
atmosphere or to another piece of equipment

You do not have to include all these components in a Pressure Relief calculation.
But the block must include at least a pipe section or a relief device.

Use the Configuration sheet on the ReliefDevice form to specify:

* Relief device type, including service for safety relief valves

* Number of inlet and tail pipe sections

« Whether the vessel neck is to be specified

* Whether the vessel neck and piping should be ignored during dynamic runs

If you choose Open Vent Pipe as the device, then:

* No relief device is allowed
¢ You must specify a vessel neck, inlet pipe, or tail pipe

For the Steady State Flow Rating of Relief Valve scenario, the venting system
consists only of a safety valve. No piping is allowed.
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Specifying the Relief Device

33-14

The following types of relief devices are available:

» Safety relief valve (both liquid and gas/2-phase)
* Rupture disk

» Emergency relief vent

* Open vent pipe (pipe section or vessel neck)

* Relief valve / Rupture disk combination

On the Configuration Sheet of the ReliefDevice form, choose the type of relief
device you wish to simulate by clicking on one of the options above. The default
relief device is a safety relief valve.

w Configuration G‘Safet_l,l‘v"alvel ErmEture [Hizk | Helief emnt | eszel Heck
— Relief device
+ Salety relief valve S arvice: I j
" Buphure disk

" Emergency relief vent
" Open vent pipe

" Relief valve / Rupture disk combination

—Inlet pipes / T ail pipes
Ma. af inlet pipes: II:I vI Ma. af tail pipes: II:I vI

— Optional
[ Model vessel neck

™| | gnere wessel neck and pipmng dunng demanmie s

Depending on the type of relief device you choose on the Configuration sheet of
the ReliefDevice form, one or more additional sheets (tabs) on the ReliefDevice
form may become active for further specification of the device. For example, if
you select Rupture disk as your relief device on the Configuration sheet, the
Rupture Disk tab will become active and display an incomplete symbol indicating
that further specifications are required on this sheet.

Each of these additional sheets is explained later in this section.

Built-in tables within Aspen Plus contain:

» Several standard commercially available valves, rupture disks, and
emergency relief vents

» All the mechanical specifications and certified coefficients needed in the relief
calculations

You can customize Aspen Plus by modifying or adding tables of valve, disk, and
vent characteristics. For more information, see Aspen Plus System Management.

Aspen Plus User Guide
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You can do one of the following:

» Choose a device from the tables
» Enter your own specifications and coefficients

For liguid service valves, you can specify the full-lift over-pressure factor. This
allows you to simulate some of the older-style valves, which do not achieve full
lift until 25% over-pressure is reached.

Safety Valve

If you select Safety Relief Valve or Relief Valve / Rupture Disk Combination as the
type of relief device, you must complete the Safety Valve sheet to specify the
safety relief valve (PSV) to be used in the simulation. Define the valve in the
Manufacturer's Tables frame. Once the Type, Manufacturer, Series, and Nominal
Diameter have been selected, a unique valve is described and Aspen Plus fills in
the following data in the Valve Parameters frame:

e Inlet Diameter

* Throat Diameter

e OQutlet Diameter

» Discharge Coefficient

If you want to use a valve not listed in the Manufacturer's Tables, you must type
in values for the Valve Parameters listed above. Note that if you select a valve
from the tables and then overwrite any of the Valve Parameters, all
Manufacturer's Tables fields will be blanked out.

To complete the form, enter the differential setpoint for the valve. This
represents the pressure difference across the valve which is needed for the valve
to start opening.

Rupture Disk

If you select Rupture Disk or Relief Valve / Rupture Disk Combination as the type
of relief device, you must complete the Rupture Disk sheet to specify the rupture
disk (PSD) to be used in the simulation. Define the rupture disk in the
Manufacturer's Tables frame. Once the Manufacturer, Style, and Nominal
Diameter have been selected, a unique PSD is described and Aspen Plus fills in
the following data in the Rupture Disk Parameters frame:

* Diameter
» Discharge Coefficient

If you want to use a PSD not listed in the Manufacturer's Tables, you must type
in values for the parameters listed above. Note that if you select a rupture disk
from the tables and then overwrite any of the rupture disk parameters, all
Manufacturer's Tables fields will be blanked out.

Aspen Plus User Guide 33-15
Version 10.1-0



Pressure
Relief
Calculations

To complete the form, enter the differential setpoint for the rupture disk. This
represents the pressure difference across the rupture disk which is needed for
the disk to break.

In an actual capacity run, the rupture disk is modeled as a pipe with an
equivalent length to diameter (L/D) ratio. If no test data is available, use L/D=8
for disk diameters larger than 2 inches (5.08 cm), and 15 for diameters 2 inches
and smaller. In a code capacity run, the rupture disk is modeled as an ideal
nozzle with the appropriate discharge coefficient. For uncertified rupture disks,
use a discharge coefficient of 0.62.

Relief Vent

If you select Emergency Relief Vent as the type of relief device, you must
complete the Relief Vent sheet to specify the emergency relief vent (ERV) to be
used in the simulation. Define the relief vent in the Manufacturer's Tables frame.
Once the Manufacturer, Style, and Nominal Diameter have been selected, a
unique ERV is described and Aspen Plus fills in the following data in:

* Recommended Setpoint
» Diameter

To complete the form, enter the differential setpoint for the relief vent. This
represents the pressure difference across the vent which is needed for the vent to
begin opening.

If you want to use an ERV not listed in the Manufacturer's Tables, you must type
in values for the diameter and differential setpoint in the Vent Parameters
frame. Note that if you select an ERV from the tables and then overwrite any of
the vent parameters, all Manufacturer's Tables fields will be blanked out.

ERVs are modeled so that they open gradually to a fully open position calculated
using the vent over-pressure factor.

Specifying the Vessel Neck

33-16

The vessel neck is a piece of pipe which connects the vessel to the first length of
inlet pipe or to the relief device if there are no inlet pipes. If you choose to specify
a vessel neck, enter the associated information on the Vessel Neck sheet of the
ReliefDevice form.

The following data are required to describe the vessel neck:

* Length
 Diameter

Aspen Plus User Guide
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Optional specifications on the Vessel Neck sheet are shown below with their
corresponding defaults:

Specification Default
Orientation Vertical
Connection Type Rounded

Reducer resistance coefficient (Reducer K) 0.04

Expander resistance coefficient (Expander 0.04
K)

Roughness 0.00015 ft

Specifying the Inlet Pipe

For inlet pipe sections, use the Pressure Relief InletPipes form to describe the
inlet pipes which connect the vessel neck to the relief device. Up to two sections
of pipe with the same or different diameters may be used.

The InletPipes form contains four sheets:

Use this sheet To

Pipe Specify the pipe dimensions and optional pipe parameters

Fittings Describe the fittings in the pipe section such as pipe connections, butterfly or gate valves,
elbows, and tees

Valves Describe a general purpose valve or control valve in the pipe section

Thermal Specify heat transfer parameters for energy transfer with surroundings

The Pipe sheet is required for all sections of inlet pipe.

The remaining sheets are used for specification of optional input. Each sheet is
described below.
Pipe

Use the Pipe sheet to enter the pipe diameter and length for each pipe section.
Pipe diameter and length are required specifications for all pipe sections.
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Included with Aspen Plus are built-in Pipe Schedule Tables that aid in the
specification of common pipe sizes.

You can customize Aspen Plus by adding or modifying pipe schedule tables. For
more information on this, see the Aspen Plus System Management manual.

To choose a pipe diameter from the built-in Pipe Schedule Tables:
1. At the top of the Pipe sheet, select a pipe section from the Pipe Section field.

2. In the Pipe Schedule frame, choose a material of construction for the pipe
section, from the Material list. Available materials include carbon steel and
stainless steel.

Choose a pipe schedule in the Schedule field.

4. Choose a nominal pipe diameter from the Nominal Diameter field.

A unique pipe is described and the Inner Diameter is displayed in the Pipe
Parameters frame.

If you want to use a pipe not listed in Pipe Schedule Tables, you must manually
enter the pipe inner diameter in the Inner Diameter field of the Pipe Parameters
frame. Note that if you select a pipe from the tables and then overwrite the inner
diameter, all Pipe Schedule Tables fields will be blanked out.

Optional inputs on the Pipe sheet include:

e Absolute pipe roughness

* Pipe Rise (elevation change)

» Resistance coefficient ("K" factor) of reducer following the pipe section

* Resistance coefficient ("K" factor) of expander following the pipe section

Aspen Plus User Guide
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If you do not enter values for these optional inputs, the following default values

are used.

Specification Default
Roughness 0.00015 ft
Pipe Rise 0
Reducer K 0.04
Expander K 0.04
Fittings

Use the Fittings sheet to describe any fittings contained in the an inlet pipe
section. Any number of the following fitting types may be specified:

» Gate Valves

e Butterfly Valves
* 90 degree Elbows
e Straight Tees

* Branched Tees

In addition a miscellaneous flow resistance may be specified by entering in the
number of pipe diameters equivalent to the resistance.

Valves

Use the Valves sheet to specify a general purpose valve to be used in a pipe
section. In the top section of the sheet, select a valve from the Manufacturer's
Tables frame. Once the Manufacturer, Style, and Nominal Diameter have been
selected, a unique valve is described and Aspen Plus fills in the following data in
the Valve Parameters frame:

*  Flow Area
* Flow Coefficient

If you want to use a valve not listed in the Manufacturer's Tables, you must type
in values for the parameters listed above. Note that if you select a valve from the
tables and then overwrite any of the valve parameters, all Manufacturer's Tables
fields will be blanked out.

You may also specify the valve constant for a control valve contained in the pipe
section. To do this, enter a value in the Valve Constant field of the Control Valve
frame.
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Thermal

Use the Thermal sheet to specify energy balance parameters if you want to model
heat transfer between the pipe section and the surroundings. The following must
be specified:

* Inlet Ambient Temperature
e Outlet Ambient Temperature
» U-value (overall heat transfer coefficient)

Specifying the Tail Pipe

For tail pipe sections, use the Pressure Relief TailPipes form to describe the tail
pipes which connect the relief device to the discharge point. Up to two sections of
pipe with the same or different diameters may be used. The TailPipes form has
the same functionality as the InletPipes form, except that it applies to tail pipe
sections. For more details on specifying tail pipes, refer to Specifying the Inlet
Pipe, earlier in this chapter.

Specifying Dynamic Input

33-20

Use the Dynamiclnput form to describe the emergency event associated with a
dynamic scenario. Required data include a description of the vessel as well as the
event (fire or heat input) which is causing the release from the vessel.

The sheets contained on the Dynamiclnput form are listed below:

Use this sheet To specify

Vessel Vessel and vessel head geometry

Design Parameters Vessel design pressure and disengagement model

Fire Type of fire exposure engulfing the vessel

Fire Credits Credits you can claim if systems to fight fire or minimize vessel releases are present
Heat Input The rate of heat input into a vessel

The Vessel and Design Parameters sheets must be completed for all dynamic
scenarios. For heat input scenarios, the Heat Input sheet is also required. For
fire scenarios, the Fire sheet is required, and the Fire Credits sheet is optional.

The use of each sheet is described below.
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Vessel

Use this sheet to describe the vessel undergoing the emergency event by
specifying:

» Vessel type and head type

» Shell orientation if the vessel type is Heat Exchanger Shell

* Vessel length and diameter

» Vessel jacket volume if vessel type is Vessel Jacket

« Vessel volume if vessel is User Specified

* Head volume and head area if head type is User Specified

The following vessel types are available:
* Horizontal

* Vertical
« API Tank
« Sphere

* Heat Exchanger Shell
¢ Vessel Jacket
» User Specified

To complete vessel specifications:

1. On the Pressure Relief Dynamiclnput Vessel sheet, choose a vessel type from
the Vessel Type list in the Vessel Description frame.

2. For vessel types of Horizontal, Vertical, APl Tank, or Heat Exchanger Shell,
select a head type in the Head Type list, and enter the length and diameter in
the Vessel Dimensions frame. Available options for head type are Flanged,
Ellipsoidal, or User Specified.

3. For Heat Exchanger Shell vessel types, enter the shell orientation (horizontal
or vertical) in the Shell Orientation list.

4. For Sphere vessel types, enter the sphere diameter in the Diameter field of
the Vessel Dimensions frame.

5. For Vessel Jacket vessel types, enter the jacket volume in the Vessel
Dimension frame.

6. For User Specified vessel types, enter the vessel volume and head volume in
the User Specifications frame.

7. If you choose a User Specified head type, enter the head volume and head
area in the User Specifications frame.
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Design Parameters

Use the Design Parameters sheet to describe vessel design characteristics by
specifying:

Maximum allowable working pressure (MAWP)

Temperature corresponding to the MAWP

Vessel disengagement model

Homogeneous vapor fraction limit for user specified disengagement model
Volume of vessel internals

Vessel disengagement models let you select how the phase behavior of fluid
leaving the vessel will be modeled. The following disengagement options are

available:

Option Description

Homogeneous Vapor fraction leaving vessel is the same as vapor fraction in vessel

All vapor All vapor leaving vessel

All liquid All liquid leaving vessel

Bubbly DIERS bubbly model

Churn-turbulent DIERS churn-turbulent model

User specified Homogeneous venting until vessel vapor fraction reaches the user-specified value,

then all vapor venting

To specify design parameters for your dynamic pressure relief scenario:

1.

On the Pressure Relief Dynamiclnput Design Parameters sheet, first enter
the Maximum Allowable Working Pressure in the Vessel Design Pressure
frame.

In the MAWP Temperature field, enter the temperature corresponding to the
specified maximum allowable working pressure.

In the Vessel Disengagement frame, select a disengagement model from the
Disengagement Model list.

Enter any vessel disengagement parameters corresponding to the selected
disengagement model:

If you choose Enter

Bubbly Bubbly disengagement coefficient (default is 1.01)
Churn-turbulent Churn-Turbulent disengagement coefficient (default is 1)
User-specified Homogeneous vapor fraction limit (no default)
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Optionally, at the bottom of the sheet, you can enter the Volume of Vessel
Internals in the Vessel Dead Volume frame. This represents the volume of
internal structures such as mixers and baffles that will be subtracted from
the calculated vessel volume.

Fire

Use this sheet to characterize the fire engulfing the vessel. A Fire Standard must
be selected so that Aspen Plus can calculate the vessel wetted area, energy input,
and how the credit factor (Fire Credits sheet) is taken. Pressure Relief can base
its calculations on any of the following standards:

* NFPA 30
* API 520
* API 2000

Choose the desired standard from the Fire Standard list in the Fire Scenario
Parameters frame.

Optional specifications on the Fire sheet include:

* Fire duration

« Area of vessel surrounded by fire (relevant when Vessel Jacket or User
Specified is selected for vessel type on the Vessel sheet)

» Liquid level in the vessel at the start of the fire (for NFPA-30 fire standard
with Vessel Types of Horizontal, Vertical, API-Tank, or Heat Exchanger
Shell)

* Vessel elevation

» Extra heat transfer area

¢ Whether vessel is portable

The details of how wetted areas and energy inputs are calculated are described in
on-line help and in Aspen Plus Unit Operation Models.

Fire Credits

Pressure Relief assumes the calculated energy input is constant during the entire
venting transient. If appropriate, you can use the Fire Credits sheet to specify a
fire credit factor which Aspen Plus uses to reduce the energy input into the
vessel. You may specify a credit factor directly or allow Aspen Plus to calculate
the credit factor based on the presence of the following systems:

» Water spray equipment

» Drainage system

* Vessel insulation

« Both drainage and fire fighting equipment

Credit for Drainage and Fire Fighting Equipment is not allowed unless Fire
Standard (Fire sheet) is AP1-520.
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Insulation Protection Factor is not allowed when vessel is portable (Fire sheet),
Fire Standard (Fire sheet) is NFPA-30, or Credit for insulated vessel (Fire
Credits sheet) is not claimed.

The details of how credit factors are calculated are described in on-line help and
in Aspen Plus Unit Operation Models.

Heat Input

Use this sheet to specify the rate of heat input into the vessel, for dynamic heat
input scenarios. The method of heat input can be specified in three ways by
selecting one of the following options in the Heat Input Method frame on the
Heat Input sheet.

e Constant duty
» Calculated from heat source
» Time-varying duty profile

If a constant duty is chosen, simply enter the constant duty in the Heat Input
Method frame.

If you choose to calculate the duty from a heat source, you must specify the
temperature, heat transfer area, and heat transfer coefficient (U-value) in the
Heat Source frame.

If you choose to enter a time-varying duty profile, use the Duty Profile frame to
enter values of duty versus time.

Specifying Reactive Systems for Dynamic Scenarios

33-24

For the dynamic scenarios of fire or heat input, you can model a protected vessel
with reactions if the Vessel Type (Dynamiclnput Vessel sheet) is one of the
following:

e Vertical

» Horizontal
« API-Tank
* Sphere

e User-specified

In the Reaction sheet of the Setup folder, specify which reactions occur within the
vessel. If there are any Kinetic or equilibrium (other than electrolytic) type
reactions, you must create a Reaction ID through the Reactions folder of the Data
Browser. Electrolytic reactions specified through the Chemistry folder are
automatically included in the pressure relief calculations and need not be
specified in the Reactions sheet. See Chapter 27 for more information on how to
specify a Reaction ID.
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To specify reactions to be used in a pressure relief calculation:

1. Make sure to select one of the dynamic scenarios (fire or heat input) on the
Setup Scenario sheet.

2. From the Pressure Relief Setup form, click the Reactions tab.

3. On the Reactions sheet, click the Include Chemical Reactions in Vessel check
box.

4. In the Vessel Reactions frame, select the desired reaction ID from the
Available list, and move them to the Selected list using the right arrow
button. To remove reactions from the Selected list, select them and click the
left arrow button. Use the double arrow buttons to move all reactions in a
selected list.

Specifying When to Stop Dynamic Calculations

When simulating the dynamic scenarios of fire or heat input, you must use the
Pressure Relief Operations form to describe the criteria that Aspen Plus will use
to terminate the dynamic simulation.

=Stop Eriterialiii' Timesl

Criterion nio.

p |Location:

anable type:

Stop wvalue:

Comparient [D:

Subztream (D

pproach franm:

On the Stop Criteria sheet of the Operations form, define one or more stop
criteria. You must define at least one stop criterion for the form to be complete. If
you define more than one stop criteria, the criterion reached first will end the
simulation.
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You may select from the following variable types when defining a stop criterion:

e Simulation time

» Vapor fraction in the vessel

» Mole fraction of a specified component

» Mass fraction of a specified component

» Conversion of a specified component

» Total moles or moles of a specified component

* Total mass or mass of a specified component

* Vessel temperature

e Vessel pressure

* Vent mole flow rate or mole flow rate of a component
¢ Vent mass flow rate or mass flow rate of a component

You must:

e Select a specification type

» Enter a value for the specification at which the simulation will stop

e Select a component and substream for component-related specification types

» Specify which approach direction (above or below) to use in stopping the
simulation.

1. To specify when to stop calculations for dynamic pressure relief scenarios:

2. Open the Pressure Relief Operations form.

3. On the Stop Criteria sheet, enter 1 in the Criterion No. field if this is the first
stop criterion. When entering multiple stop criteria, number them
sequentially, starting with 1.

4. From the Location list, choose a location (Vessel, Vent, or Vent Accumulator)
for calculating the variable that will be defined as the stop criterion.

5. In the Variable Type list, choose a stop criterion variable type from the list
shown above.

6. In the Stop Value field, enter the value of the variable at which to stop the
simulation.

7. For component-related specification types, select a component and a
substream from the Component ID list and the Substream ID list
respectively.

8. In the Approach From list, specify which approach direction (above or below)
to use in stopping the simulation.

9. Repeat steps 2 through 7 for each additional stop criterion.
10. When finished defining all stop criteria, click the Times tab.

11. On the Times sheet, specify an upper limit for the time of the scenario to be
simulated, in the Maximum Time field.
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12.

13.

14.

In the Time Intervals Between Result Points frame, enter the time interval to
report result for the scenario. Enter this value in the When Vent is Closed
field. Aspen Plus will report result profiles in the time interval you specify. If
you wish to use a different interval when the vent is open, enter this value in
the When Vent is Open field. If you do not enter a value for When Vent is
Open, the interval specified for When Vent is Closed will be used throughout
the entire scenario.

In the Optional frame at the bottom of the sheet, you can request to include
profile points when the relief system opens or closes. This option is checked
by default. Click this option to deselect it.

Also in the Optional frame, you can limit the maximum number of result
points in the profile by entering a value in the Maximum No. of Result Points
field. The default for this value is the specified maximum time divided by the
report time interval for results you have specified for When Vent is Closed.

If you have specified a results time interval for When Vent is Open that is
smaller than When Vent is Closed, you should increase the default value for
Maximum No. of Results Points.

Examining Results of Pressure Relief
Calculations

1.

To examine results of pressure relief calculations:

From the Data menu, point to Flowsheeting Options, then Pressure Relief.

2. On the Pressure Relief Object Manager, select the Pressure Relief ID of

interest, and click Edit.

In the left pane of the Data Browser, click the appropriate results form for
the selected Pressure Relief block.

For steady-state scenarios click the SteadyStateResults form.

For dynamic scenarios, click the DynamicResults form.

Steady-State Results

Use the SteadyStateResults form to view calculated results for steady state
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The SteadyStateResults form is comprised of two sheets:

Use this sheet To view

Summary Input summary, whether code requirements are met, and inlet and tail pipe pressure changes
Property Profiles Property profiles for points along the relief system

Summary

Use this sheet to view:

* Input summary (Scenario, Relief Device type, and Capacity option)

* Whether code requirements are met

» Actual flow rate through the emergency relief system as calculated by
Aspen Plus

« Estimated flow rate you provided on the Setup Scenario sheet.

» Actual and allowed pressure loss through the vessel neck and inlet pipes

e Actual and allowed backpressure in the tail pipes

If code requirements are not met, you should review the status messages. Your
system may not meet code requirements because:

e Inlet pipe pressure loss is too high

» Tail pipe pressure loss is too high

e The 97% rule has been violated

» Choke point(s) do not occur at the relief device

For inlet piping, the actual (calculated) loss is the pressure loss through the
vessel neck and the inlet pipes computed at 10% overpressure. If this field is
blank, it means that the source pressure was greater than 10% overpressure. The
allowed pressure loss is the value calculated from the allowed inlet pipe pressure
loss as a percentage of differential set pressure as specified on the Setup Rules
sheet.

For outlet piping, the actual (calculated) backpressure is computed at 10%
overpressure. If this field is blank, it means that the pressure was greater than
10% overpressure or the 97% rule was used instead. The allowed pressure loss is
the value computed from the maximum allowed percentage specified on the
Setup Rules sheet.

Property Profiles

Use this sheet to view property profiles for points along the emergency relief
system. The following properties are shown:

e Status (e.g., OK, or Choked)
e Pressure

e Temperature

e Vapor Fraction
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Dynamic Results

Use the DynamicResults form to view calculated results for dynamic simulations.
The DynamicResults form is comprised of seven sheets:

Use this sheet To view

Summary Input summary, whether code requirements are met, and inlet and tail pipe pressure changes
Parameters Summary of dynamic results and vessel pressures and temperatures

Vessel Vessel properties versus operation time

Vent Property profiles for points along the relief system versus operation time

Accumulator Accumulator properties versus operation time

X-Y-Z Vessel, vent, and accumulator mole fractions versus operation time

Vessel Mass Component mass amounts in vessel per substream versus operation time

Each results sheet is discussed below.

Summary

Use this sheet to view:

* Input summary (Scenario, Relief Device type, and Capacity option)

*  Whether code requirements are met

» Initial, final, maximum and allowed vessel pressures

e Initial, final, maximum and allowed vessel temperatures

» Actual and allowed pressure loss through the vessel neck and inlet pipes
e Actual and allowed backpressure in the tail pipes

If requirements are not met, you should review the status messages. If your
simulation fails to meet code requirements, possible causes are:

« Inlet pipe pressure loss at 10% over-pressure is too high
» Tail pipe pressure loss at 10% over-pressure is too high
e The 97% rule has been violated

* Choke point(s) do not occur at the relief device

¢ Vessel pressure goes above the maximum allowed

For inlet piping, the actual (calculated) loss is the pressure loss through the
vessel neck and the inlet pipes computed at 10% overpressure. If this field is
blank, it means that the source pressure was greater than 10% overpressure. The
allowed pressure loss is the value calculated from the allowed inlet pipe pressure
loss as a percentage of differential set pressure as specified on the Setup Rules
sheet.
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For outlet piping, the actual (calculated) backpressure is computed at 10%
overpressure. If this field is blank, it means that the pressure was greater than
10% overpressure or the 97% rule was used instead. The allowed pressure loss is
the value computed from the maximum allowed percentage specified on the
Setup Rules sheet.

Parameters

Use this sheet to view:

» Operation time (the time for which the simulation ran)

» Calculated vessel volume

» Calculated vessel wetted area

« Fire heat input, based upon the wetted area and fire credit factors

» Fire credit factor

* Vent maximum flow (the maximum flow rate through the emergency relief
system calculated during the simulation)

Allowed vessel conditions are based upon your input for vessel maximum
pressure on the Setup Rules sheet.

Vessel

This results sheet displays a table of vessel properties versus operation time. The
following vessel properties are shown:

e Status

* Vent flow

e Pressure

e Temperature
» Vapor fraction
* Total mass

The status column indicates where the choke is, if not at the device. Listed below
is an explanation of the possible status symbols:

Status Meaning

CL Vent closed

OK Acceptable choke location and pressure
N Choke at vessel neck

VF Choke at valve flange

11 Choke at Inlet Pipe 1

12 Choke at Inlet Pipe 2

T1 Choke at Tail Pipe 1

Continued
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Status Meaning

T2 Choke at Tail Pipe 2
SH Large static head
XT Excess tail pressure
Vent

This sheet lets you view profiles for points along the relief system versus
operation time for the following properties:

Temperature
Pressure
Vapor fraction
Mass density

Accumulator

The Accumulator sheet lets you view accumulator properties versus operation
time. The following accumulator properties are shown:

Pressure

Temperature

Vapor fraction

Total mass in the accumulator

X-Y-Z

The X-Y-Z sheet lets you view component mole fractions versus operation time
for the following phases and locations:

Overall contents of the vessel (Vessel Total)

Vapor phase of vessel (Vessel Vapor)

Overall contents of the relief system (Vent Total)
Overall contents of the accumulator (Accumulator Total)
Liquid phase of vessel (Vessel Liquid)

Vessel Mass

The Vessel sheet lets you view the component mass amounts in the vessel versus
operation time for the substream you select.
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Example of Dynamic Run of a Pressure Relief System

This example shows the results after a dynamic run of a pressure relief system. The first
screen shows the DynamicResults with the Summary sheet displayed:

Summary I Pararneters I Vezzel I et I Bccurnulatar I L I Wezzel Mazs

Scenarnio;

— Bun surnrmarny

Relief device:
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TEMPERATURE F
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Inserts

An insert is a partial backup file that you can import into a run at any time.

Aspen Plus provides special data packages as inserts which can be used as
starting points for building new simulations, or they can be imported into
existing simulations. You can create your own inserts for later use.

This chapter discusses this use of files including:

* Whatis an insert?

* Creating an insert

e Importing inserts

* Creating a property package

e Resolving ID conflicts

e Using electrolyte inserts from the Aspen Plus insert library
e Hiding objects
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Creating an Insert

You can use an insert to create a:

Property package, consisting of component and property definitions
Standard process unit, such as a crude column and its preheat train

You can create your own inserts, or you can import inserts from the Aspen Plus
library of inserts. For more information, see Using Electrolyte Inserts From the
Aspen Plus Insert Library on page 34-6.

To create an insert, you need to save a backup file containing the information you
want in your insert:

1.

Begin with a run that has all of the input for the insert defined. (The run does
not have to be complete.) This can consist of any possible simulation input
such as components, properties, streams, blocks, flowsheeting options, model
analysis tools, etc.

From the File menu, click Export.
In the Save As Type box, select Aspen Plus Backup Files (*.bkp).

Enter a path and a filename for the backup file that you want to contain the
insert.

Click Save.

You can import the backup file you created into any run.

Importing Inserts

34-2

To import an insert into an existing Aspen Plus simulation:

1.

With the existing simulation active in the Aspen Plus main window, from the
File menu, click Import.

In the Save As Type box, select Aspen Plus Backup Files (*.bkp).

On the Import dialog box, locate the insert, select it, and click Open.

If the Resolve ID Conflicts dialog box appears, see Resolving ID Conflicts on
page 34-3.

After importing the insert into your existing run, your simulation will contain
the input from both files.
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Resolving ID Conflicts
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When you import one file into another, some imported objects may have the same
IDs as objects in the existing run. When this happens, Aspen Plus displays the
Resolve ID Conflicts dialog box, which lists all objects that have matching IDs in
the two files.

Rezolve ID Conflicts Ed
Ohject | Status | Heplace
Blocks B1 [HEATER])

Properties Prop-Setz H=DESIGM

Propertiez Prop-Setz THERMAL fdEerae

Properties Prop-Setz T<PORT -

Properties Prop-Setz VLE Edit i

Properties Prop-Sets WWLLE _

Streams 1 [MATERIAL]

Streams 2 [MATERIAL] sl Erefiv

Add| Sttt

[IEelete
[

Cancel

Help
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Use the Resolve ID Conflicts dialog box to resolve ID conflicts by one of the

following methods:

Method

Procedure

Replace existing objects

1. Select one or more objects.

2. Click Replace.

Aspen Plus deletes the objects in the current run and replaces them
with the objects being imported.

Merge new objects with
existing objects

1. Select one or more objects.

2. Click Merge.

Aspen Plus merges specifications for inserted objects with those of
objects in the current run. If both objects have values for the same
specification, the inserted object overrides the object in the current run.

Edit IDs directly

1. Select one object at a time.
2. Click Edit ID.
3. In the Object Name dialog box, specify a new ID for the object.

Add a prefix or suffix to the
existing IDs

1. Select one or more objects.

2. Click Add Prefix or Add Suffix.

3. In the Prefix (or Suffix) dialog box, enter characters to be added to the IDs in the existing
run.

Delete imported objects

1. Select one or more objects.

2. Click Delete.

Aspen Plus deletes the selected objects from the imported run,
leaving those objects in the existing run unchanged.

When finished resolving each ID conflict, click OK.

Merged objects must be of the same type. For example, you can merge two
RadFrac blocks, but not a RadFrac block with a Flash2 block.

Example of Importing an Insert and Resolving ID Conflicts

Simulate a distillation column with two different feeds in the same run. The
distillation column specifications are identical.

1. Create the flowsheet for the first feed and complete all specifications for the

problem.

2. From the File menu, click Save As.

3. In the Save As Type box, specify Aspen Plus Backup Files (*.bkp). Specify a
name for the file in the File Name box. Click OK.

4. From the File menu, click Import.

In the Files of Type box, select Aspen Plus Backup Files (*.bkp). Locate and
select the file you just saved. Click OK.

6. In the Resolve ID conflicts dialog box, select the block and streams. Hold
down the Ctrl key while clicking on each item. Then click Add Suffix.
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7. In the Suffix dialog box, enter -2, and click OK.

8. The Resolve ID Conflicts dialog box now shows the new IDs for the inserted
objects.

9. Select all the remaining objects in the Resolve ID Conflicts dialog box and
click Delete.

10. In the Resolve ID Conflicts dialog box, click OK.

Aspen Plus adds the new block, and streams to the flowsheet.

Example of Copying a Block from One Run to Another

This example assumes that two runs have identical Sep2 component splitters. The block 1D
and the inlet and outlet stream IDs for Sep2 are the same in both runs. Replace Sep2 with an
identical RadFrac rigorous distillation model in both runs.

1. Replace Sep2 with RadFrac in the first run, and complete the specifications.

2. From the File menu, click Save As and save the file as an Aspen Plus Backup
File (*.bkp).

Open the second run.

From the File menu, click Import. Select the file you saved in step 2 and click
OK.

5. In the Resolve ID Conflicts dialog box, select the RadFrac block and all the
streams listed. Click on the Replace button.

6. Select all the remaining objects in the Resolve ID Conflicts dialog box and
click Delete.

7. In the Resolve ID Conflicts dialog box, click OK.

The new RadFrac block, with all of its specifications, now replaces the Sep2
block in the flowsheet.

Creating a Property Package

To create a property package:

1. Begin with a run that has all of the input for the property package defined,
including all components and properties specifications. (The run does not
have to be complete.)
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Typically this would include:

» Components specifications

* Henry-Comps specifications, if defined

» Chemistry specifications, if defined

* Properties specifications

* Property method definitions other than built-in property methods

* Any Properties Parameters objects with data specified

* Any units sets, other than SI, MET, or ENG, used by any of the forms in
the property package

« Any property sets you want to include

From the File menu, click Export.

In the Export dialog box, enter a path and a filename for the backup file that
you want to contain the property package.

Click Save.

You can import the backup file you created into any run.

For example, suppose you develop a property package for ethanol-water using the
NRTL property method. Specify the following information in Aspen Plus, and
save the specifications as a backup file:

Components Specifications Selection sheet
Properties Specifications Global sheet
Properties Parameters Binary Interaction NRTL-1 form

Using Electrolyte Inserts From the
Aspen Plus Insert Library

34-6

To use an insert from the Aspen Plus library:

1.

a > D

From the File menu, click Import.

On the Import dialog box, click the Favorites button on the toolbar.

In the Favorites folder, double-click the Elecins folder.

Select an insert from the list and click Open.

If the Resolve ID Conflicts dialog box appears, see Resolving ID Conflicts on
page 34-3.

Tip To see a description on the insert, use the Preview button on the Import
dialog box toolbar.
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Tip To view in detail the contents of an insert before using it, follow the
procedure above, except open the insert using File Open, instead of File
Import. Then use the Data Browser to see what input is defined in the insert
and to look at the insert contents.

Hiding ODbjects

You can use the Hide feature to temporarily remove optional objects from a
simulation, without deleting them. For example, you can hide a design specification
when you don't want it to be applied to the simulation.

You cannot hide:

» Global specifications, such as the Setup Specifications and Properties
Specifications forms

e« Components

* Blocks and streams

* Properties Parameters and Molecular Structure objects

To hide objects:
1. Display the Object Manager for the type of object you want to hide.

2. Select one or more objects you want to hide. If the Hide button is dim, you
cannot hide this type of object.

3. Click the Hide button.

Aspen Plus removes the selected objects from the Object Manager list. They
are no longer part of the problem definition.

Revealing Objects

Aspen Plus User Guide
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To reveal (unhide) objects:
1. Open the Object Manager for the type of object you want to reveal.

2. Click the Reveal button.

Note The Reveal button will only be active if there are hidden objects.

3. On the Reveal dialog box, select the hidden objects you want to reveal, and
click OK.

If there are no ID conflicts, Aspen Plus restores the objects to the problem
definition, and they are displayed on the Object Manager.
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If the specifications for a hidden object are inconsistent with the current
problem definition (for example, if a referenced stream no longer exists), the
object will be incomplete. Use Next to find out what you must do to complete
the input.

If there are ID conflicts (if a hidden object has the same ID as an object in the
current problem definition), the Resolve ID Conflicts dialog box appears.

Tip Use the Remove button on the Reveal dialog box to permanently delete
hidden objects from the simulation.
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35 Creating Stream
Libraries

This chapter describes how to create stream libraries. For information on how to
retrieve information from a stream library for use in a simulation, see Chapter 9.

» Creating or modifying a stream library
e STRLIB command summary
e Description of STRLIB commands

You can retrieve information about stream composition and conditions from a
stream library, instead of entering this data on stream forms.

This table shows what you can do with the stream library capability:

To Do This

Create a library of frequently Store the composition and conditions of frequently used feed streams
used feed streams in a stream library. Retrieve this information from different models in
a simulation without re-entering it.

Transfer stream information Simulate one section of your flowsheet, store the outlet streams in a library,
from one simulation to and retrieve the information in another simulation.
another Or use a stream library to share information between two groups

that are simulating different sections of a process.

Initialize tear streams Store final tear stream values from a simulation in a library.
When you simulate another case, retrieve the desired values as an initial guess
for the tear stream. If you do not know which stream will be chosen
as the tear stream, store all the streams from the first simulation
and retrieve all the streams in the new run.

Isolate a block from a large Store streams for a large flowsheet in a library.

flowsheet Retrieve and analyze one block from the stored flowsheet and
simulate the block by itself, perhaps with higher diagnostics or
at different conditions. This eliminates re-entering the stream information
for the isolated block run.
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Creating or Modifying a Stream Library

You can:

» Create your own stream library
» Use a stream library created and maintained by your Aspen Plus system
administrator

To create or modify a stream library, use STRLIB, a program delivered with
Aspen Plus. Every Aspen Plus run produces a summary file, which contains all
the results of the simulation. STRLIB copies stream results from an Aspen Plus
summary file into a stream library. You can store data from any number of
Aspen Plus runs in one stream library.

A stream library is organized in cases. You identify a stream by the:

e Stream name
» Case to which it belongs

Each case usually corresponds to one Aspen Plus run. However, you can store
streams from more than one Aspen Plus run in a single case. You can also store
data from a single run in several cases.

Using STRLIB, you enter commands to create or modify a stream library. The
most common use of STRLIB involves these steps:

1. Opening a summary file using the OPEN command.

2. Establishing the case where you want to copy streams, using the OPEN or
CASE commands.

3. Adding or replacing streams in the library, using the ADD or REPLACE
commands.

Running STRLIB Interactively

To run STRLIB interactively, enter this command at the operating system
prompt:

strlib libname

Where libname is the stream library you want to create or modify. The stream
library name can be up to eight characters long.

Library files have the extension *.slb.

When the STRLIB> prompt appears, you can enter commands.
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STRLIB prompts you for each command.

Running STRLIB in Batch Mode

You can run STRLIB non-interactively to create or update a stream library.
Running STRLIB in batch mode automatically adds all the streams from the
summary file produced by an Aspen Plus run.

To run STRLIB in batch mode, enter this command at the operating system
prompt:

STRLIB libname runid [case]

libname is the name of the library you want to create or modify. If the library
does not exist, it will be created and initialized to contain 10 cases.

runid is the name of the Aspen Plus summary file from which you want to
transfer streams.

case is the case name where you want to add streams. If you do not specify the
case name, STRLIB uses the runid from the summary file as the case name.

The batch mode STRLIB command is equivalent to the following sequence of
commands when you run STRLIB interactively:

STRLIB> OPEN runid [case]
STRLIB> ADD  ALL
STRLIB> EXIT

STRLIB Command Summary

This table lists a summary of the commands you can use in STRLIB. The
commands are described in more detail in this chapter.

You can abbreviate any STRLIB command. Enter all commands at the STRLIB>
prompt, typing enough letters to identify the command as unique. The first one
or two letters are usually enough.
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STRLIB Commands

Command

Description

ADD

Add a stream to the library.

CASE

Change the current case.

DELCASE

Delete a case from the library.

DELSTREAM

Delete a stream from the library.

DIRECTORY

List the cases in the library and the streams in a case.

DUMP

Write stream information to a file.

END

End STRLIB and update the library.

EXIT

End STRLIB and update the library.

HELP

Display interactive help on STRLIB commands.

INITIALIZE

Initialize a library.

LIST

List streams in the summary file.

LOAD

Load stream information from a dump file.

OPEN

Open a summary file.

PACK

Pack (compress) the library.

RENAME

Rename a stream in the library.

REPLACE

Replace a stream in the library.

QuIT

End STRLIB without updating the library.

Description of STRLIB Commands

ADD

The ADD command copies a stream from an Aspen Plus summary file to the

library. The stream to be copied must not already exist in the current case of the

library. (Use the REPLACE command to replace streams that already exist.)

Specify ADD ALL to copy all streams from a summary file to the library.

Syntax:

[stream— 1D

ADD
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CASE

The CASE command changes the current case. Streams in the stream library are
organized into cases. You establish a case when you open a summary file (using
the OPEN command) or when you use the CASE command. For more information
about cases, see Creating or Modifying a Stream Library on page 35-2.

The ADD, DELSTREAM, DUMP, RENAME, and REPLACE commands apply to
streams in the current case.

Syntax:

CASE casename

DELCASE

The DELCASE command deletes a case from the library. All streams in the case
are deleted.

Syntax:

DELCASE casename

DELSTREAM

The DELSTREAM command deletes a stream from the current case.

If you delete many streams from a library, you should use the PACK command to
recover the deleted space. See the PACK command description, this section.

Syntax:

DELSTREAM stream-id

DIRECTORY

The DIRECTORY command lists the cases and streams stored in the stream
library. If you do not specify a case in the DIRECTORY command, STRLIB lists
all the cases in the library and the number of streams in each case. If you specify
a case, STRLIB lists only the streams in that case.

Syntax:
DIRECTORY [casename]
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DUMP

The DUMP command writes the information about a stream stored in the
library. STRLIB prompts you to specify whether you want to write to the
terminal or to a file. If you write to a file, STRLIB prompts you for the filename.
Specify DUMP ALL to dump all streams from all cases in a library.

Use DUMP if you want to:

* View the information for a stream
e Transfer information from one library to another

If you need to reinitialize a library to increase the maximum number of cases
that can be stored, use the DUMP ALL command first to save the contents of the
library. To restore the information, use the LOAD command.

Syntax:

DUMP [stream- ID%
ALL O

END

The END command ends the STRLIB session. The stream library is updated
with all the changes you made during the session. The END and EXIT commands
are synonymous. (Use the QUIT command to end STRLIB without updating the
library, so changes made during the session are not saved.)

Syntax:
END

EXIT

The EXIT command ends the STRLIB session. The stream library is updated
with all changes you made during the session. The END and EXIT commands are
synonymous. (Use the QUIT command to end STRLIB without updating the
library, so changes made during the session are not saved.)

Syntax:
EXIT

HELP

The HELP command activates the interactive help system, so you can obtain
help for STRLIB commands.
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Syntax:
HELP [command]

INITIALIZE

The INITIALIZE command destroys all data in a stream library. Use it only
when creating a library or after using the DUMP ALL command.

The INITIALIZE command initializes a new stream library. You must specify the
maximum number of cases the library will contain. Enter the INITIALIZE
command before performing any operations on a new stream library.

Syntax:
INITIALIZE numcase

LIST

The LIST command lists the streams in the current summary file.
Syntax:
LIST

LOAD

The LOAD command loads information from a dump file created with the DUMP
command. STRLIB loads all cases and streams.

Syntax:
LOAD filename

OPEN

The OPEN command opens a summary file, so that streams from an Aspen Plus
run can be transferred to the library. If you do not specify a case name, STRLIB
uses the RUNID from the summary file as the case name.

Syntax:

OPEN filename [casename]
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PACK

The PACK command packs the stream library to recover blank spaces created
when streams are deleted. The PACK command is necessary only if you delete
many streams from a library and want to recover unused file space.

Syntax:
PACK

RENAME

The RENAME command renames a stream in the library. RENAME applies only
to the current case.

Syntax:

RENAME oldname newname

REPLACE

The REPLACE command replaces a stream in the current case with a stream of
the same name from a summary file. If the stream does not exist in the library,
STRLIB adds it.

Specify REPLACE ALL to copy all streams from a summary file to the library,
overwriting any streams of the same name that exist in the library.

Syntax:
[stream— 1D
REPLACE
ALL E
QUIT

The QUIT command ends the STRLIB session. The stream library is not updated
with any changes made during the current STRLIB session. (Use the END or
EXIT commands to end STRLIB and update the stream library with the changes
made during the session.)

Syntax:
QUIT
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Example of Creating a Library with Two Cases

Create a stream library that can contain two cases. Add streams S1 and S2 from
summary file RUN1. Also add all the streams from summary file RUN2.

STRLIB> INITIALIZE 2
STRLIB> OPEN RUN1.SUM
STRLIB> ADD S1

STRLIB> ADD S2

STRLIB> OPEN RUN2.SUM
STRLIB> ADD ALL
STRLIB> END

The library will be organized in two cases, RUN1 and RUN2.

Example of Creating a Library with One Case

Create a stream library that can hold five cases. Create one case, PROJECT. Add
streams PROD1 and PROD2 from summary file RUN1, and stream FEED1 from
summary file RUN2.

STRLIB> INITIALIZE 5

STRLIB> OPEN RUN1.SUM

STRLIB> CASE PROJECT

STRLIB> ADD PROD1

STRLIB> ADD PROD2

STRLIB> OPEN RUN2.SUM

STRLIB> CASE PROJECT

STRLIB> ADD FEED1
STRLIB> END

The OPEN command creates a new case if a case name is not specified. The
library must be initialized to hold at least three cases. The preceding set of
commands will create two empty cases named RUN1 and RUN2.

To avoid creating the empty cases, use the case name in the OPEN command.
STRLIB> INITIALIZE 5

STRLIB> OPEN RUN1.SUM PROJECT

STRLIB> ADD PROD1

STRLIB> ADD PROD2

STRLIB> OPEN RUN2.SUM PROJECT

STRLIB> ADD FEED1

STRLIB> END
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Stream Summary Formats

Aspen Plus allows you to customize stream reports and tables using Table Format
Files (TFFs). Using TFF language, you can customize the:

e Results Summary Streams form and block StreamResult sheets to your own
format, for analyzing your simulation results

» Stream table in a process flow diagram (PFD), to meet your company's
standards

A Table Format File contains easy-to-understand language that you can use to:

» Display a selected list of stream properties of interest, in a specified order

e Add or change labels for stream properties

« Manipulate the format of stream property values (for example, scaling,
normalization, units conversion, and trace cut-off)

This chapter explains how to create and use TFFs. Sample TFFs are provided.
Read this chapter if you plan to customize your stream summary form or the
stream table in your process flow diagram (PFD).

Topics include:

About the Aspen Plus TFFs
Creating a TFF
Basic Stream Result Properties
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About the Aspen Plus TFFs

Aspen Plus provides several Table Format Files in your system directory. If you
installed Aspen Plus in the default directory, your system directory is Program
Files\AP10UI\xeq.

By default Aspen Plus displays the stream summary and stream table based on the
built-in TFF for the Application Type you chose when creating your simulation.

Choose a stream format to display your stream report from:

» The Stream Format fields on the Setup Specifications Stream Report
* The Format field on the ResultsSummary Streams Material sheet or the block
StreamResults Material sheet

All of the TFF files located in either the system directory or in the working
directory are displayed in the list. You can modify any Aspen Plus TFF or create
your own. TFF files should be placed either in your working directory or in the
system directory.

Aspen Plus uses the TFF you select in either field for all Results Summary
Streams sheets you display, until you select another TFF.

To select a stream format:

1. Move to the Stream Format field of the Setup Specifications Stream Report
sheet, the ResultsSummary Streams Material sheet, or the block
StreamResults Material sheet.

2. Click the list and scroll through the options, looking at the descriptions of
each TFF.

3. Select a TFF. If you are using built-in TFFs, it is recommended that you
select one of the TFFs for your Application Type. For example, if you are
using one of the Petroleum Application Types, choose a TFF beginning with
Petro.

It is not necessary to re-run the simulation in order to see the results in another
format.
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Creating a TFF

You can:

» Edit the TFFs provided with Aspen Plus to customize your stream summary
and stream tables. These files are located in the Program Files\AP10UI\xeq
directory if you installed Aspen Plus in the default directory.

» Use TFF language to create your own TFF.

The sections that follow describe how to edit or create a new TFF. You may also
want to refer to the example TFFs included at the end of the chapter.

TFF File Format and Options

Use TFF language to customize your stream summary or stream table. Follow
these rules:

» TFF sentences are not case sensitive.
* Any line beginning with a semi-colon in column 1 is treated as a comment line.
» The ampersand (&) is used to continue a line.

The format for the TFF and a description of the format follow.

TITLE = value

STREAMS=value

STREAM-ID-LABEL = value

SOURCE-LABEL = value

DEST-LABEL = value

PHASE-LABEL = value

BEGLOOP SUBSTREAM = value

ENDLOOP

DISPLAY qualifier optional qualifier=value  option=value

Qualifiers:

ALL ONLY REMAIN

Optional qualifiers:

SUBSTREAM COMPS PHASE BASIS TEMP PRES LVPCT COMP-ATTR
SUBS-ATTR

Options:

FORMAT PPM PPB TRACE TRACE-LABEL ZERO-LABEL MISSING-LABEL
PROP-HEADER COMPS-HEADER SUBSTREAM-HEADER PB-HEADER

TEMP-HEADER PRES-HEADER LVPCT-HEADER COMP-ATTR-HEADER
SUBS-ATTR-HEADER COMP-ATTR-ELEM SUBS-ATTR-ELEM
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PROP prop-name  qualifier=value option=value

Optional qualifiers:

SUBSTREAM COMPS PHASE BASIS TEMP PRES LVPCT
COMP-ATTR SUBS-ATTR

Options:

FORMAT PROP-LABEL UNITS UNITS-LABEL NORMALIZE SCALE
SCALE-LABEL PPM PPB TRACE TRACE-LABEL ZERO-LABEL
MISSING-LABEL MW BP MW-BP-FORMAT HEADER PROP-HEADER
COMPS-HEADER SUBSTREAM-HEADER PB-HEADER TEMP-HEADER
PRES-HEADER LVPCT-HEADER COMP-ATTR-HEADER SUBS-ATTR-HEADER
COMP-ATTR-ELEM  SUBS-ATTR-ELEM

TEXT "Text enclosed in double quotes”

36-4 Aspen Plus User Guide
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TFF Sentences

TITLE

STREAMS

STREAM-ID-LABEL

Aspen Plus User Guide
Version 10.1-0

This section describes each sentence that you can use in a TFF.

Title for the stream table. The TITLE line must be the first non-comment line in the TFF. If you
choose to wrap the stream table, TITLE is not repeated. TITLE is not displayed in the Results
Summary Streams form.

TITLE=YES .....cccovevveeees The title you specified on the Setup Specifications form is used. If no title is
specified on Setup Specifications, the title Heat and Material Balance Table
is used.

TITLE=NO ..o, No title is displayed. (Default)

TITLE="string" ................. The string (up to 64 characters) enclosed in double quotes is used as the

title for the stream table.

Use to define a set of streams and their order on the Results Summary Streams form and in the
stream table.

STREAMS=sid-list ........... List of stream IDs

If the STREAMS statement is not in your TFF, all streams are displayed in
alphanumeric order. (Default)

You can interactively select the streams and the order they are displayed on
the Results Summary Streams form.

Label for the stream ID row in the stream table. See Header Sentence Order in the Stream Table, this
chapter.

STREAM-ID-LABEL=YES The label Stream ID is used.
STREAM-ID-LABEL=NO.. The Stream ID row is not displayed. (Default)
STREAM-ID-LABEL="string" The string (up to 20 characters) in double quotes is used as the label.

36-5



Stream
Summary
Formats

SOURCE-LABEL Label for the source block row in the stream table. See Header Sentence Order in the Stream Table,
this chapter.

SOURCE-LABEL=YES.... The label From is used.
SOURCE-LABEL=NO...... The source block row is not displayed. (Default)
SOURCE-LABEL="string" The string (up to 20 characters) enclosed in double quotes is used as the

label.
DEST-LABEL Label for the destination block row in the stream table. See Header Sentence Order in the Stream
Table, this chapter.
DEST-LABEL=YES........... The label To is used.
DEST-LABEL=NO............. The destination block row is not displayed. (Default)
DEST-LABEL="string"..... The string (up to 20 characters) enclosed in double quotes is used as the
label.
PHASE-LABEL Label for the phase row for the MIXED substream. See Header Sentence Order in the Stream Table,

this chapter.
PHASE-LABEL=YES........ The label Phase is used.
PHASE-LABEL=NO........... The phase row is not displayed. (Default)

PHASE-LABEL="string".. The string (up to 20 characters) enclosed in double quotes is used as the
label.

BEGLOOP, ENDLOOP  Optional sentences that enable you to control the display of properties when there are two or more
substreams. You can define groups of DISPLAY sentences by enclosing them between pairs of
BEGLOOP and ENDLOOP sentences. Aspen Plus displays properties specified by the enclosed
DISPLAY sentence for one substream at a time, looping through all requested substreams.

SUBSTREAM........cccveennee List of substreams to loop through
SUBSTREAM=ssid-list..... List of substream IDs
SUBSTREAM=ALL ........... All substreams

DISPLAY Used to control the display of the stream properties. DISPLAY is usually used in conjunction with one
or more PROP sentences. PROP sentences can control the order and display of individual properties.
You can have any number of DISPLAY sentences in a TFF.

DISPLAY ALL ....cccccvuverenee Display all stream properties identified by the specified qualifiers. (See
Qualifier Descriptions for DISPLAY and PROP, this chapter.) Use the
format described by the options. (See Option Descriptions for DISPLAY and
PROP, this chapter.)

DISPLAY ONLY .......ccu. Display only the stream properties specified by the PROP sentences
following the DISPLAY ONLY sentence. Use the order of the PROP
sentences, with the specified qualifiers and options.

DISPLAY REMAIN ............ Display the remaining stream properties (those not already specified by
DISPLAY or PROP sentences). Identify stream properties by the specified
qualifiers, in the format described by the options.
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Used to control the display of an individual property. When used in conjunction with

DISPLAY ONLY, PROP sentences specify the order in which the properties are displayed. See
Qualifier Descriptions for DISPLAY and PROP, and Option Descriptions for DISPLAY and PROP,
this chapter.

Prop-name...........ccccuvveee... Stream property. This is the Prop-Set name for a stream property (for
example, MOLEFLMX for total mole flow). Prop-Set names are listed in
the Property field on the Prop-Sets form. A property displayed in the
stream summary or a stream table must be one of the basic stream result
properties listed in the table on page 36-8 , or the property must be
included in a prop-set ID in the Property sets field on the Setup
Specification Stream Report form. All such properties appear in standard
stream reports for your run.

If your TFF requests a stream property that is not in listed in the table or
included in a prop-set ID, Aspen Plus does not display the property.

The options specified with the PROP sentence are combined with the DISPLAY options when
Aspen Plus displays the properties. If the same option is specified for PROP and the preceding
DISPLAY sentence, the PROP specification is used.

Allows you to insert a text line within the side label of your stream table. Enclose text in double
quotes. To insert a blank line, use a pair of double quotes with a space between them.
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The following table lists the basic stream result properties.

Basic Stream Result Properties

Prop-Name Description

MOLEFLOW' Component mole flow
MASSFLOW' Component mass flow

VLSTD' Component standard volume flow
MOLEFRAC' Component mole fraction
MASSFRAC' Component mass fraction
VLSTDFR' Component standard volume fraction
MOLEFLMX Total mole flow

MASSFLMX Total mass flow

VOLFLMX Total volume flow

TEMP Temperature

PRES Pressure

VFRAC Vapor fraction

LFRAC Liquid fraction

SFRAC Solid fraction

HMX Enthalpy (in mole, mass, and flow basis)
SMX Entropy (in mole and mass basis)
RHOMX Density (in mole and mass basis)
MWMX Average molecular weight
COMP-ATTR Component attributes
SUBS-ATTR Substream attributes

CMASS_TIME'T

Component mass flow rate during actual operation

CMOLE_TIME'"

Component mole flow rate during actual operation

cvoL_TIVE

Component standard volume flow rate during actual operation

CMASS_CYCLE'

Component mass per cycle

CMOLE_CYCLE'"

Component mole per cycle

cvoL_cycLe™

Component standard volume per cycle

CYCLE TIME"

Cycle time

OPER_TIME'"

Operation time

Continued

Aspen Plus User Guide
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Basic Stream Result Properties (continued)

Prop-Name Description

NTRAIN'T Number of trains

MASS_TIMETJr Total mass flow rate during actual operation
MOLE_TIMETJr Total mole flow rate during actual operation
VOL_TIMETJr Total volume flow rate during actual operation
ENTH_TIMETJr Total enthalpy flow rate during actual operation
MASS_CYCLEJrT Total mass per cycle

MOLE_CYCLETJr Total mole per cycle

VOL_CYCLEJrT Total volume per cycle

ENTH_CYCLEJrT Total enthalpy per cycle

t Property is available if the corresponding option is selected on the Setup.Main form.

T Batch stream properties. Displayed only if you use the Report.Batch-Operation form.

Qualifier Descriptions for DISPLAY and PROP

Aspen Plus User Guide
Version 10.1-0

This section describes the qualifiers you can use in both DISPLAY and PROP
sentences. You can think of the combined DISPLAY and PROP qualifiers as a
property filter. Any property in the stream report that passes the filter is
displayed.

The qualifiers listed are all possible specifications for a Prop-Set property, except
UNITS. See Option Descriptions for DISPLAY or PROP, this chapter. The only
gualifiers that apply to the basic stream report properties are SUBSTREAM and
COMPS. The basic stream result properties do not display if the PHASE or
BASIS qualifiers are set to any value other than the default (ALL).

SUBSTREAM.......ccveeveeen. Substreams for which the property is to be displayed
SUBSTREAM=ssid-list....  List of substream IDs
SUBSTREAM=ALL .......... All substreams (Default)

COMPS ..o, Components for which the property is to be displayed
COMPS=cid-list............... List of component IDs
COMPS=ALL.....c.ccevrernne All components (Default)
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PHASE .....oooiiiiieeee, Phase for which the property is to be displayed
PHASE=V ....ccooiiiiiiiins Vapor
PHASE=L ........ccccvvvveeenns Total liquid
PHASE=L1 .......cccccevveernne 1st liquid
PHASE=L2........ccccceeeernn. 2nd liquid
PHASE=S......cccccccciiinnnnns Solid
PHASE=T ... Total mixture
PHASE=ALL .....c....ccvnenn. All phases of the property in the stream report

(Default)

BASIS.......c oo, Basis for which the property is to be displayed
BASIS=WET .......ccoceerunnn. Includes water
BASIS=DRY ......cccccerrurernnn Excludes water
BASIS=ALL.......cccvvveenn... All bases of the property in the stream report

(Default)

TEMP ...t Temperatures for which the property is to be displayed
TEMP=list......cccccovvivnnnenn.. List of temperatures
TEMP=ALL.......ccvvvreen.... All temperature values of the property in the

stream report (Default)

PRES....cccccoiiiiiiiiieiieeee Pressures for which the property is to be displayed
PRES=list........ccccvvveenenn. List of pressures
PRES=ALL ....cccceeevviinnns All pressure values of the property in the

stream report (Default)

LVPCT . Liquid volume percents for which the property is to be displayed
LVPCT=list..ccoveeeiieiiiie, List of liquid volume percents
LVPCT=ALL .....cccvvvrerennn. All liquid volume percent property values in

the stream report (Default)

COMP-ATTR ..o Component attributes to be displayed
COMP-ATTR=cattr-list.... List of component attributes
COMP-ATTR=ALL ........... All component attributes (Default)

SUBS-ATTR ... Substream attributes to be displayed

36-10

SUBS-ATTR=sattr-list..... List of substream attributes
SUBS-ATTR=ALL ............ All substream attributes (Default)
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Option Descriptions for DISPLAY and PROP

This section describes the options for the DISPLAY and PROP sentences. These
options control the display, side label, and units of a property value.

FORMAT ..oovvivieeiiiiiieeeen, Stream property value display format string, enclosed in double quotes.
(Default=customized G format designed to show maximum precision) See
Formats for Numbers, this chapter. Applies to both DISPLAY and PROP
sentences.

PROP-LABEL ................... Stream property label to override the Aspen Plus property label. Can be
used, for example, to replace the Aspen Plus property name MUMX with
the label Viscosity. Applies to PROP sentence only. May be truncated in
the stream summary, but displays in full in the stream tables.

UNITS. .o Stream property value units of measurement (Setup.Units-Set1,
Setup.Units-Set2 and Setup.Units-Set3 forms), enclosed in double quotes.
Property value is converted to your specifications. A stream property may
be available in more than one type of unit. For example, enthalpy for a
stream may have units-types of mole-enthalpy, mass-enthalpy, and
enthalpy-flow. In this case the specified units define both the units and
the units types to be displayed. If no units are specified, the stream
property is displayed in all available units types. The units specification
is overridden if you select a units-set on the Results Summary Streams
form, but the units-types selection is sustained. Applies to PROP only.
(Default=global out-units for basic stream result properties and local
units for each additional prop-set).

UNITS-LABEL........ccuvee.. Label for units of measurement. The Units label is a character string
enclosed in double quotes. Overrides the Aspen Plus Units label. Can be
used, for example, to print the units label in lowercase characters.
Applies to PROP sentence only, and only if the UNITS qualifier is used.

NORMALIZE ..........ccueeeee. Normalization flag for component flow or fraction properties
NORMALIZE=YES ............ Normalize property values. See The
NORMALIZE Option, this chapter.
NORMALIZE=NO.............. Do not normalize values. (Default)

Applies to DISPLAY and PROP sentences

SCALE ...oooviiiiiiieieeee, Scale factor. Property value is divided by scale factor before it is
displayed. Used to reduce the magnitude of printed values. You must also
specify SCALE-LABEL. Applies to PROP sentence only.

SCALE-LABEL ................. Scale factor label enclosed in double quotes. Appears in front of the units
label or UNITS-LABEL you supply. Applies to PROP sentence only.

PPM. i Parts per million cut-off value. Property values below the specified
number are displayed as PPM. For example, if you specify PPM=1E-3,
any property values smaller than 0.001 are displayed as 1 PPM to 999
PPM. Applies only to component flow or fraction properties. See The
NORMALIZE Option and PPM, PPB and TRACE Options, this chapter.
Applies to both DISPLAY and PROP sentences.

PPB ..oiiiiiiiiiiiiiee e Parts per billion cut-off value. Property values below the specified
number are displayed as PPB. For example, by specifying PPB=1E-6,
property values smaller than 0.000001 are displayed as 1 PPB to 999
PPB. Applies only to component flow or fraction properties. See The
NORMALIZE Option and PPM, PPB, and TRACE Options, this chapter.

Aspen Plus User Guide 36-11
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Applies to both DISPLAY and PROP sentences.

TRACE ....ovvvvvieeieiiiiiiee. Trace cut-off value. Property values smaller than the specified cut-off
value are not displayed. The character string specified by TRACE-LABEL
is displayed instead. Applies to both DISPLAY and PROP sentences. See
PPM, PPB, and TRACE Options, this chapter.

TRACE-LABEL ................. Trace symbol for displaying trace value, enclosed in double quotes
(Default=blank). Applies to both DISPLAY and PROP sentences.

ZERO-LABEL..........cccuve.. Label for zero value enclosed in double quotes (Default=0.0). Applies to
both DISPLAY and PROP sentences.

MISSING-LABEL............... Label for property values not calculated, enclosed in double quotes
(Default=blank). Applies to both DISPLAY and PROP sentences.

MW e Molecular weight display. Applies to component-dependent properties
only. Displays in the units column in the stream summary or stream
table.

MW=YES .........coocvveveeen Display molecular weight next to the
component ID.

MW=NO ..o Do not display molecular weight. (Default)
Applies to PROP sentence only.

BP oo Boiling point display. Applies to component-dependent properties only.
Displays in the units column in the stream summary or stream table.

BP=YES.........coerirrrrernnnn. Display boiling point next to the component ID.
BP=NO .....ccooeiveeeeeiie, Do not display boiling point. (Default)
Applies to PROP sentence only.
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MW-BP-FORMAT ............. Molecular weight or boiling point format string, enclosed in double quotes
(Default=%.0f). See Formats for Numbers, this chapter. Used when
MW=YES or BP=YES.

Applies to PROP sentence only.
HEADER ......cccccoveeeiiiiins Header above a property

HEADER="string" ............ The specified string of up to 20 characters is
displayed in the line above the property side
label. (Default: no header)

Applies to PROP sentence only.

PROP-HEADER................ Property header
PROP-HEADER=YES....... Property label is displayed. (Default)
PROP-HEADER=NO......... Property label is not displayed.

PROP-HEADER="string". The specified string of up to 20 characters is
used as the property label and overrides the
PROP-LABEL specification. You can use the
TFF variables @PROP (property label) and
@UNITS (units label) within this string. Can be
truncated in the stream summary but displays
in full in the stream table.

Applies to both DISPLAY and PROP sentences.
COMPS-HEADER............. Component header. Used with component-dependent property only.

COMPS-HEADER=YES....Component header, consisting of a component
ID, is used. The component ID is indented two
spaces. (Default)

COMPS-HEADER=NO......The component ID is not displayed.

COMPS- The specified string of up to 20 characters is

HEADER="string"............ used as the component header. The TFF
variable @COMPS (component ID) can be used
within this string. Can be truncated in the
stream summary but displays in full in the
stream table.

Applies to both DISPLAY and PROP sentences.
SUBSTREAM-HEADER.... Substream header

SUBSTREAM- Substream header of the form "Substream: ssid"
HEADER=YES ............o.... is used. (Default)

SUBSTREAM- Substream header is not displayed.
HEADER=NO..........c.cc0e..

SUBSTREf‘Mj . The specified string of up to 20 characters is
HEADER="string used as the substream header. The TFF

variable @QSUBSTREAM (substream ID) can be
used within this string. Can be truncated in the
stream summary but displays in full in the
stream table.

Applies to both DISPLAY and PROP sentences.
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PB-HEADER ..........ccceeee..

TEMP-HEADER.................

PRES-HEADER.................

LVPCT-HEADER...............

36-14

Phase-Basis header

PB-HEADER=YES ............ Phase-Basis header of the form "basis phase" is
used. (Default)

PB-HEADER=NO............... Phase-Basis header is not displayed.

PB-HEADER="string" ...... The specified string of up to 20 characters is

used as the Phase-Basis header. The TFF
variables @BASIS (basis) and @PHASE (phase)
can be used within this string. Can be truncated
in the stream summary but displays in full in
the stream table.

Applies to both DISPLAY and PROP sentences.

Temperature header. Used when the property is calculated at a specified
temperature.

TEMP-HEADER=YES ....... Temperature header of the form **Temperature
value**" is used. (Default)

TEMP-HEADER=NO ......... No temperature header is displayed.

TEMP-HEADER="string". The specified string of up to 20 characters is
used as the temperature header. You can use
the TFF variable @ TEMP (temperature) within
this string. Can be truncated in the stream
summary but displays in full in the stream
table.

Applies to both DISPLAY and PROP sentences

Pressure header. Used when the property is calculated at a specified
pressure.

PRES-HEADER=YES........ Pressure header of the form"**Pressure
value**" is used. (Default)

PRES-HEADER=NO ......... No pressure header is displayed.

PRES-HEADER="string" . The specified string of up to 20 characters is
used as the pressure header. You can use the
TFF variable @PRES (pressure) within this
string. Can be truncated in the stream
summary but displays in full in the stream
table.

Applies to both DISPLAY and PROP sentences.

Liquid volume percent header. Used with liquid volume percent
dependent properties only.

LVPCT-HEADER=YES......Liquid volume percent header, consisting of a
liquid volume percent, is used. (Default)

LVPCT-HEADER=NO ....... Liquid volume percent is not displayed.

LVPCT- The specified string of up to 20 characters is

HEADER="string" ............ used as the liquid volume percent header. You
can use the TFF variable @LVPCT (liquid
volume percent) within this string. Can be
truncated in the stream summary but displays
in full in the stream table.

Aspen Plus User Guide
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COMP-ATTR-HEADER.....

SUBS-ATTR-HEADER......

COMP-ATTR-ELEM..........

SUBS-ATTR-ELEM

Applies to both DISPLAY and PROP sentences.

Component attribute header

COMP-ATTR- Component attribute header of the form "cid
HEADER=YES ........c......... cattr-id" is used. (Default)

COMP-ATTR- Component attribute header is not displayed.
HEADER=NO....................

COMP-ATTR- The specified string of up to 20 characters is
HEADER="string" .............. used as the component attribute header. You

can use the TFF variable @COMPS (component)

and @COMP-ATTR (component attribute)
within this string.

Applies to both DISPLAY and PROP sentences.

Substream attribute header

SUBS-ATTR- Substream attribute header of the form "ssid
HEADER=YES ...........cc.... sattr-id" is used. (Default)

SUBS-ATTR- Substream attribute header is not displayed.
HEADER=NO.......ccccccceer.n.

SUBS-ATTR- The specified string of up to 20 characters is
HEADER="string" used as the substream attribute header. You

can use the TFF variable @SUBS-ATTR
(substream attribute) within this string.

Applies to both DISPLAY and PROP sentences.

Component attribute element to be displayed. For example, component
attribute SULFANAL has three elements: PYRITIC, SULFATE, and

ORGANIC.

COMP-ATTR-ELEM=cattr-  List of component attribute elements
elem-list

COMP-ATTR-ELEM=ALL. All elements (Default)
Applies to both DISPLAY and PROP sentences.
Particle size distribution interval number to be displayed.

SUBS-ATTR-ELEM=sattr-  List of particle size distribution intervals
elem-list........ccooeeiiiiiiiiinnnn.

SUBS-ATTR-ELEM=ALL.. All intervals (Default)
Applies to both DISPLAY and PROP sentences.
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Header Sentence Order in the Stream Table

The order of the header sentences (TITLE, STREAM-ID-LABEL, SOURCE-
LABEL, DEST-LABEL, PHASE-LABEL) in your TFF indicates the order of header
information in the stream table. The order of these sentences has no effect on the
stream summary form. You must specify YES or supply your own label to display a
header on the stream table.

You can specify up to 20 characters for STREAM-ID-LABEL, SOURCE-LABEL,
DEST-LABEL, and PHASE-LABEL. Your specified label does not appear on the
stream summary form.

Formats for Numbers

There are three conversion formats (%-xx.yye, %-xx.yyf, %-xx.yyg). The conversion
format variables are:

Variable Explanation

% Percent character. Lead character for format specification.

- Optional minus sign, which left-justifies the number. Without the minus sign, the number is right-justified.

XX A digit string specifying a minimum field length for the converted number. The number takes at least this much
space to print, and more if necessary.

yy A digit string specifying the precision, (that is, the number of digits) to be printed to the right of the decimal point.

e Number is converted to the form [-Ja.bbbbbbbe[+]cc. Length of b is specified by yy (Default is 6). Use
uppercase E in the format specification for uppercase E in the printed numbers.

f Number is converted to the form [-Jaaa.bbbbbb. Length of b is specified by yy (Default is 6).

g The shorter of %e or %f is used. Use uppercase G in the format specification for uppercase G in the printed
numbers.

The recommended format is %10.2f. This format prints values with two digits to

the right of the decimal, if there is room. If the number is greater than 9,999,999,
Aspen Plus eliminates the fractional digits, then spills over the field range to the
left.
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Other common formats used in stream tables are:

Stream table format Prints
%10.0f Whole numbers, with no decimal digits or exponents
%20.nf Numbers without exponents and with n digits to the right of the decimal point, if there is room.

Decimal points line up, unless decimal digits have been eliminated in some numbers.

%10.nE Numbers in exponential notation, with n+1 significant digits

The f format is most common in stream tables. You can use the SCALE option, or
"large units" (for example, MMBTU/HR instead of BTU/HR). This option reduces
the size of the value printed, so it fits in the table with the f format specification.

Any number forced to display as zero with the specified f format is displayed as
"< number", where number is the smallest number that can be displayed by that
format. For example, the number 0.002 displayed under the %10.2f format is

< 0.01.

The NORMALIZE Option

The NORMALIZE option is used with the component flows or fraction properties,
as shown in the following table:

If the component property is Then it is normalized to

Mole flow (MOLEFLOW) Total mole flow (MOLEFLMX) of the same substream

Mass flow (MASSFLOW) Total mass flow (MASSFLMX) of the same substream

Standard vapor volume (VVSTD) Total standard vapor volume (VVSTDMX) of the same substream
Standard liquid volume (VLSTD) Total standard liquid volume (VLSTDMX) of the same substream
Mole fraction (MOLEFRAC) 1

Mass fraction (MASSFRAC) 1

Standard vapor volume fraction (VVSTDFR) 1

Standard liquid volume fraction (VLSTDFR) 1

The component property displayed is forced to add up to exactly the
normalization value. For example, suppose you display mass fractions with two
digits (such as %10.2f) and NORMALIZE = YES. Aspen Plus adjusts the new
fractions to sum to exactly 1.00, even if the value of each mass fraction rounded
to 2 digits adds up to 0.99.
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PPM, PPB, and TRACE Options

The options FORMAT, PPM, PPB, and TRACE are related when you specify a
format on the flow or fraction properties. For example, assume you have the
following specification:

PROP MOLEFLOW FORMAT="%10.3f" PPM=1e-3 PPB=1le-6 TRACE=1e-9

This specification is shown in this diagram:

TRiCE PlPB PiM
BEERRERERRE
0 10" 10° 10° 10° 1
If MOLEFLOW is Then the value is displayed as
Not calculated Blank or string specified in MISSING-LABEL
0 0.0 or string specified in ZERO-LABEL
<10° Blank or string specified in TRACE-LABEL
10°< MOLEFLOW < 10° 1-999 PPB
10° < MOLEFLOW < 10° 1-999 PPM
<10° <0.001
>10° Number as converted by the %10.3f format

You should always maintain the following relationship:

TRACE < PPB < PPM < Format precision
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Example of a Full TFF

The following is the system default TFF. The intent of this TFF is to mimic the Aspen Plus

stream report as closely as possible.

This TFF mimics the Aspen Plus stream report and reports all

; calculated properties.

titte=yes
stream-id-label=yes
source-label=yes
dest-label=yes
phase-label=yes

begloop substream=all

display all

prop moleflow prop-label="Mole Flow"
prop massflow prop-label="Mass Flow"
prop vistd prop-label="Liq Vol 60F"
prop molefrac  prop-label="Mole Frac"
prop massfrac  prop-label="Mass Frac"
prop vistdfr  prop-label="LiqVolFrac60F"
prop moleflmx  prop-label="Total Flow"
prop massflmx  prop-label="Total Flow"
prop volfimx  prop-label="Total Flow"
prop vistdmx  prop-label="Lig Vol 60F"

prop temp prop-label="Temperature"
prop pres prop-label="Pressure"

prop vfrac prop-label="Vapor Frac"
prop Ifrac prop-label="Liquid Frac"
prop sfrac prop-label="Solid Frac"
prop hmx prop-label="Enthalpy"

prop smx prop-label="Entropy"

prop rhomx prop-label="Density"

prop mwmx prop-label="Average MW"

batch properties follow
first, component-dependent properties

prop cmass_time prop-label = "Mass Flow"
prop cmole_time prop-label = "Mole Flow"
prop cvol_time prop-label = "Vol Flow"
prop cmass_cycle prop-label = "Mass/Cycle"
prop cmole_cycle prop-label = "Mole/Cycle"
prop cvol_cycle prop-label = "Vol/Cycle"

; overall stream properties

prop cycle_time prop-label = "Cycle Time"
prop oper_time prop-label = "Operat Time"
prop ntrain prop-label = "No. Trains"
prop mass_time prop-label = "Mass Flow"
prop mole_time prop-label = "Mole Flow"
prop vol_time  prop-label = "Vol Flow"
prop enth_time prop-label = "Enthalpy"
prop mass_cycle prop-label = "Mass/Cycle"
prop mole_cycle prop-label = "Mole/Cycle"
prop vol_cycle prop-label = "Vol/Cycle"

prop enth_cycle prop-label = "Enthalpy/Cycle"

éndloop
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This is a general TFF that handles any stream class and any number of property
sets. The BEGLOOP and ENDLOOP statements enclose the DISPLAY ALL
keyword, which instructs Aspen Plus to loop through all substreams and display
all properties found in each substream.

The header sentences (TITLE, STREAM-ID-LABEL, SOURCE-LABEL, DEST-
LABEL, and PHASE-LABEL) are specified to take on the default values. The
order of the header sentences dictates how they are printed in the stream table.
Since these sentences are specified before any DISPLAY sentences, the header
information is displayed above the stream values in the stream table.

Whenever Aspen Plus displays a property that is mentioned in the system
default TFF, the corresponding property label is used. For example, when

Aspen Plus displays density, the label "Density" is used. The default label is used
for any property without a specified label. For example, the label RHOMX is used
if PROP-LABEL="Density" is not specified.

All six combinations of component flow or fraction (mole, mass, standard volume)
are specified to anticipate your specifications. If Aspen Plus cannot find the
property you specify, nothing appears.
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Example of Customizing a TFF for Generating a Stream Table

Create the following TFF file to customize your stream table:

titte="Ethylene plant separation train - Section 105"

stream-id-label="Streams"

display only format="%10.2f" substream-header=no

prop molefrac prop-header="Comp mole fraction" &
comps-header=" @comps" mw=yes mw-bp-format="%6.1f"

&
normalize=yes ppm=1l1e-3 trace=1le-7 trace-label="---

text

prop moleflmx prop-label="Total Mole Flow" &
units="LBMOL/DAY" units-label="Lbmol/Day" &
scale=1e3 scale-label="M"

prop massflmx prop-label="Total Mass Flow" &
units="LB/DAY" units-label="Lb/Day" &
scale=1e3 scale-label="M"

text

prop temp prop-label="T" units="F" units-label="Deg F"

prop pres prop-label="P" units="PSI" units-label="Psi"

prop rhomx  prop-label="Density" units="LB/CUFT" &
units-label="Lb/Cuft"

Notice the following in the stream table:

e The stream ID label is customized. The source and destination labels are not
printed.

« The DISPLAY ONLY sentence limits the display to the following properties:
component mole fractions, total mole flow, total mass flow, temperature,
pressure, and mass density. The format is 2-decimal-place precision.

* For the mole fraction section, the component IDs are indented two spaces.
The molecular weights are displayed next to the component IDs with 1-
decimal-place precision. The mole fractions are normalized to 1.

» The possible mole fraction values are displayed according to FORMAT, TRACE,
PPM, and TRACE-LABEL specifications, as described in the following table:

IfMOLEFRAC is Then value is displayed as

Not calculated Blank

0 00

<107 —

10" < MOLEFRAC << 10° <1PPM

10°< MOLEFRAC << 10° 1-999PPM

10°< MOLEFRAC << 10° <001

>10° Number as converted by the %10.2f format
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« Total mole flow is requested with units of "LBMOL/DAY." Total massflow is
requested with units of "LB/DAY."

» Two blank rows are inserted for cosmetic purposes.

» Three properties (temperature, pressure, and mass density) are requested.
The property labels for these properties are customized.
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37 Working with Other
Windows Programs

The Aspen Plus Windows user interface is built using Microsoft's OLE
Automation (ActiveX™) technology. This technology enables you to transfer data
easily to and from other Windows® programs. It enables you to access
simulation data and methods through an Automation client, such as Visual
Basic® (VB).

This chapter describes how to use the Windows interoperability features. Topics
include:

* About copying, pasting and OLE

* Copying and pasting simulation data

* Copying and pasting plots

» Creating active links between Aspen Plus and other Windows applications
e Using embedded objects in your flowsheet

Chapter 38 contains more information on the Aspen Plus OLE Automation server
and how to access it through Visual Basic.

About Copying, Pasting, and OLE

Because Aspen Plus Version 10 is a true Windows application, you can take
advantage of full Windows interoperability and object linking and embedding
(OLE). You can make your simulation work more productive by creating active
links between input/output fields in Aspen Plus and other applications such as
Word® and Excel®.

Aspen Plus User Guide 37-1
Version 10.1-0



Working with
Other
Windows
Programs

For example, simulation results such as column profiles and stream results can
be pasted into a spreadsheet for further analysis, into a word processor for
reporting and documentation, into a design program, or into a database for case
storage and management.

Live data links can be established that update these applications as the process
model is changed to automatically propagate results of engineering changes. The
benefits to you are quick and error-free data transfer and consistent engineering
results throughout the engineering work process.

The subsequent sections of this chapter provide details about cutting, pasting,
and creating active links using OLE.

Copying and Pasting Simulation Data

37-2

In Aspen Plus, data contained in the fields of input and result forms can be
copied and pasted using the standard Copy and Paste commands on the Edit
menu. For example, you can copy information from a field or group of fields in
Aspen Plus, and then paste it into:

* Another location within the same Aspen Plus simulation
* Another Aspen Plus simulation
* Any other Windows application such as Word, Excel, or Access®

Copying Data

To copy information in Aspen Plus using the Copy command:
1. Select (or highlight) the information you wish to copy.

To select an individual field of data, simply click the mouse in the field.

To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.

When copying values from a table, you can:

* Click-and-drag the mouse over a desired range of results
» Select an entire column of data by clicking the column heading
e Select an entire row of data by clicking the row selector button (on the left
of the row of data)
« Select the entire table by clicking the button on the top left corner of the
table
2. From the Edit menu, click Copy, or on the keyboard, press Ctrl + C.

The selected values are now contained in the Windows paste buffer, and can
be pasted into Aspen Plus, or another Windows application.

Aspen Plus User Guide
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Note: When selecting data to be copied from a field in Aspen Plus, the entire
field of information is copied, not just a selected portion of the field. For
example, if a field contains as its value the number “1234.567”, you cannot
use the mouse to highlight a portion of the value (such as “123") for copying.

The Copy command always copies the whole field, with these exceptions:

» The Setup Specifications Description sheet
* Any Fortran or Declarations input sheet
* The Comments dialog box for individual forms

Use the text box on these sheets for entering information, and to select and
copy information.

Copying with Format

By default, the Copy command copies only the value (or values) of information.
Use the Copy with Format command from the Edit menu to request that the
label, units and basis for the values be included with the value.

To copy information in Aspen Plus using the Copy with Format command:
1. Select (or highlight) the information you wish to copy.

To select an individual field of data, click the mouse in the field.

To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.

Tip: When copying values from a table, you can click-and-drag the mouse
over a desired range of results, or you can select an entire column or row of
data by clicking the column heading or row selector button.

2. From the Edit menu, click Copy with Format.
3. On the Copying dialog box that appears, click the check boxes representing
the type(s) of information that you want to be included in the copy buffer.
Copying... |

v Yalue
[T Label

™ Uni Cancel |

[T Basis

4. Click OK.

The selected information is now contained in the Windows paste buffer, and
can be pasted into Aspen Plus, or another Windows application.
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Note: You can change the default formats included with the standard Copy
command, by selecting options in the Copy Buffer Format frame of the
General sheet on the Tools Options dialog box. See Chapter 16 for more
details on the Tools Options dialog box.

Pasting

To paste information in Aspen Plus using the Paste command:

1.

First, ensure that the paste buffer contains information that has been copied
from Aspen Plus, or another Windows application.

Click the mouse in the input field where you wish to paste the information.
For multiple fields of information, click in the upper-left most field.

From the Edit menu, click Paste or on the keyboard, press Ctrl + V.

If prompted with a message asking if you want to extend the grid, click Yes.
Aspen Plus needs to extend the grid if you are pasting more rows or columns
of data than are currently displayed.

The information contained in the paste buffer will now appear in the field, or
group of fields you selected with the cursor. This information remains in the
paste buffer, and can be pasted into additional locations by repeating steps 2
through 4.

Note The Paste command has automatic filtering which prevents the pasting of
inconsistent or inappropriate information. For example, you cannot paste a real
value into an integer input field.

Example of Cutting and Pasting Within Aspen Plus

In this example, stream results are pasted into stream input fields. This is a
common task when you want to save final results as initial estimates for tear
streams.

1. Open stream results. To do this, click the tear stream to select it, then click it

with the right mouse button. On the popup menu that appears, click Results.

In the Data Browser, click the left mouse button on the molar flowrate of the
first component in the list, and drag the mouse down to select all the values
for component molar flowrates.
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Diizplay: | | Format: |

ﬂ Stream Table

Subztream: MI=ED

bale Flow  1bmaldhr
| H2
2
C1
BEZ

(o |

=l
-

Tip If all the component flowrates are not displayed, you can expand the
Data Browser window to display more components. Or you can select the
component flowrates by holding down the Ctrl key and clicking with the

mouse.

From the Edit menu, click Copy.

Using the Data Browser, open the Streams Input Specifications sheet for the

tear stream.

In the Composition frame, click in the first cell in the Value column.

From the Edit menu, click Paste.

G‘Specificatinnsl Flazh Options ]

Substream name: |iii-|'-'| IXED

=

State vanables Compozition

|Temperature ﬂ |MDIE-FIDW ﬂ |Ibmu:u|£hr ﬂ

| |F j Component

= - p HZ

| — _ J L 14 75ER707

| [osi = CT 473 5326206
EZ 100 061556

Totalflow — {Mole = CH 44.2837872

| {Ibmal/he |

S

Tatal: |532.95522
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The molar flowrates from the stream results have been copied into the stream
input specifications. You can now enter two state variables (you could also copy
these values if you wish) to complete the initial estimates for this tear stream.

Example of Pasting Aspen Plus Results Into Other Applications

This example shows the steps necessary to paste column profile results from a
RadFrac block in Aspen Plus into an Excel spreadsheet.

1.

Open the column profile results. To do this, in the Process Flowsheet window,
click the RadFrac column to select it, then click it with the right mouse
button. From the menu that appears, click Results.

In the left pane of the Data Browser window, click the Profiles results form.
On the Profiles result form, click and drag over the results you wish to copy.

Hold down the Ctrl key while you click the column headings for the data you
wish to copy.

TPFQ l Compositions K. alues ] ] ]

Wi | Summary ﬂ B asiz bole =

Prafiles

Stage| Temperature | Pressure Heat duty | Liguid flow | % apor flow

[F =lesi e = lfbmolhe = |fibmole =]

From the Edit menu, click Copy.
Open a spreadsheet in Excel.

Select a cell in the Excel spreadsheet where you want to paste the
information.

From the Edit menu in Excel, click Paste.
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2 Microzoft Excel - Book1
23_1 File Edit “iew Insert Format Tools Data Window Help ;@ﬂ
EE ESEY 4&BRT o ew = & 2
Arial -0 - B J U ESEE=E ~d-A-
| B2 | = 1
A | B | ¢ | b | E | F | G—T

1 | e
2

3

4

5

6

¥

8 {.
9

10

11

12

13

14 -
4[4 » [pI] Sheet1 ¢ Sheetz £ Sheets ; ,{Sheeta ;’ v
Ready Sum=137822.3443

The copied RadFrac results profile has been pasted into the spreadsheet,
where it can be manipulated, reformatted, combined with additional data,
and plotted using the features of Excel. This same data could also be pasted
into other applications such as a table in Word, or a database in Access.
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Example of Pasting Data From Another Application Into Aspen Plus

In this example, atmospheric Txy data for ethyl acetate and ethanol will be
copied from an Excel spreadsheet and pasted into a Properties Data form in

Aspen Plus.

The Excel data is shown below:

. Microzoft Excel - YLE Data_xls

”@ File Edit Wew Insert Format Tools Data Window  Hi

NEEERY sbBRI - A& =& @
Arial - 10 B;u|§§§|:::::::,@.,ﬂ, -
Al | =
A B | ¢ [ o | E [ F | &7

1 | Txy data for Ethyl Acetate and Ethanol

2 FPressure =1 atm

3 Compositions are for Ethyl Acetate

4

5 Temp (€ X ¥

a 7045 a a

i 774 0.0245 0.0577

g 772 0.0305 0.0706

5 /B8 0.04E8 0.1007

10 /BB 0.0535 01114

11 /B4 0.0515 0.1245

12 /6.2 .09 0.1391

13 761 00734 | 01447

14 755 N0e4s 01633 hd
[4 4 » M Sheetl ¢ Sheetz f sheets / | 4] | LIJJ
Ready | | | | MU | [

1. In the Aspen Plus simulation, create a properties data set of an appropriate
type to input the data. In this case, open or create a mixture Txy data set
(from the Properties Data Object Manager) for the components ethyl acetate
and ethanol, at a pressure of 1 atmosphere. For more information on creating

property data sets, see Chapter 31.
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— Components in mixture
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=

Data bype: | Ty

NEEE

— Selected componentz ——

ETOAC
ETHANOL

(lempernaturne:;

Fressure:

— Conztant temperature or prezsure

Composition bagis

C

atrn

-
=

IMD|E fraction

=

2. Open the Properties Data mixture form for the newly created data set, and
examine the format for the columns of data. Modify units and standard
deviations if necessary.

Notice that there are columns for the compositions of ethanol, as well as ethyl
acetate. The composition for the second component need not be entered, as it
will be calculated as the difference between 1 and the composition of the first
component. This means that you must use two copy and paste operations to

transfer the data from Excel to Aspen Plus:

* Firstly, copy the Temperature and X columns
e Then copy the Y column

o Setup wData |JEDnstraints |

[rata type: ITXY

— Experimental data

Generate data... |

TEMPERATURE | X Y ¥
Usage ||C =||[EToAC lllETHaNOL = |l[ETOAC =||[ETHA
StdDev |01 01% 0% 1% 0%
#*
T ]
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3. Open the Excel spreadsheet containing the data.

4. Click and drag to select the data to be copied. For the first copy operation,
select the temperature and liquid composition data.

2 Microzoft Excel - VLE Data_xls
”ﬁ File Edit “jew Insert Format Tools Data Window Help -|5’|5|
DEH @Ry BRI v-~- a®|( =z s g
Arial - 10 - BIH|§§E|Ev A
BS I =| 75.45
A 8 [ ¢ [ o [ E [ F | 67

1 Txy data for Ethyl Acetate and Ethanol

2 FPressure = 1 atm

3 Compositions are far Ethyl Acetate

i

5 Temp (C) X ¥

6 {0

7 { 0.0577

g | 00706

9 | 0.1007

10 | 01114

11 | 0.1245

12 | 01391

13 b 0.1447

14 ; | N 1F33 -
4[4[ [pi[ sheet1 / | 4] | HJJ
Select desting| | Sum=4401.3046 [ NI | oz

5. From the Edit menu in Excel, click Copy.

In Aspen Plus, on the Data sheet for the newly created data set, select the
first empty cell in the Temperature column.

From the Aspen Plus Edit menu, click Paste.

8. In the Paste dialog box, click Yes to extend the data grid.

The temperature and liquid composition data is transferred into the Data
sheet.
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J Setup ' Data |JEun$traint$ |

D ata type: ITW

Generate data... |

— Expenmental data
TEMPERATURE | ¥ v s

Usage | jJIETDAc Q [ETHaNOL ; [ETOAC jJIETHA
StdDev |01 0% 73 1% 0 |«
Data 70,45 0 1 :I
Data 7T 0.0248 09752
Data 772 0.0308 09692
Data 6.8 0.0463 09532
Data 766 0.0535 00465 -

RN o

9. Return to the Excel spreadsheet, and select the vapor composition data, by
clicking and dragging the mouse.

10. From the Edit menu in Excel, click Copy.

11. In Aspen Plus, on the Data sheet, select the first empty cell in the Y column
for ethyl acetate.

12. From the Aspen Plus Edit menu, click Paste.

The vapor composition data is transferred into the Data sheet.

You can now use this data set to estimate or regress property parameters in
Aspen Plus. For more information on Property Estimation or Property

Regression, see Chapters 30 and 31 respectively.

Copying and Pasting Plots and Other Images

Aspen Plus User Guide

Version 10.1-0

After generating plots in Aspen Plus, you can copy the plots and paste them into
the process flowsheet or into other Windows applications as images. Plotted
results can be of column profiles, sensitivity analyses, batch profiles, property
analyses, and so on. You can also copy images created in other Windows
applications, such as graphs created in Excel, and paste them into the
Aspen Plus process flowsheet.

To copy a plot in Aspen Plus:
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Generate the desired plot and format the appearance of the plot as you want
it to appear when pasted. For details on creating and formatting plots, see
Chapter 13.

Select the plot in the Aspen Plus main window.
From the Edit menu, click Copy.
The plot is copied to the paste buffer.

Use Paste to paste the plot into the process flowsheet, or into other Windows
applications.

To paste a plot into the process flowsheet:

1.
2.
3.

Ensure that the paste buffer contains the desired plot or other image.
Click in an empty part of the process flowsheet.

From the Edit menu, click Paste.
The image appears as an icon in the process flowsheet.

You can move or resize the image, like any object in the flowsheet drawing. If
the image is a plot, you can also change its formatting. To do this, click the
plot with the right mouse button. From the menu that appears, click
Properties. For more information on formatting plots, see Chapter 13.

Attaching Plots or Images to Flowsheet Blocks

When a plot or image has been pasted onto the process flowsheet, you can attach
(or associate) the image to a block on the flowsheet. Attaching an image to a
flowsheet block ensures that when the block is moved, the image will maintain is
location with respect to the block.

For example, if you paste a plot of column profiles onto the flowsheet, you
typically want this to be displayed near the column.

To attach an image to a flowsheet block:

1.
2.

Select the image that you wish to attach.

Click with the right mouse button on the image, and from the menu that
appears, click Attach.

The cursor changes to a cross-hair symbol.

Click the flowsheet block to which you want to attach the image.

The image is now attached to the selected flowsheet block. If the block is later
moved to another location on the flowsheet, the image will maintain its
spatial arrangement with respect to the block.

Aspen Plus User Guide
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Example of Copying a Plot and Pasting it onto the Process Flowsheet

In this example, a plot of RadFrac composition profiles will be copied and pasted
onto the process flowsheet.

1. First, use the Plot Wizard to generate the plot of composition profiles, and
format it as you wish.

= Block B1: Yapor Composition Profiles - Plot

Block B1: Vapor Cowposifion Profiles

TOLUEME
; FHEMOL
WICH
11
Staget
16
il

0 01 0z 03 04 05 06 07 08 09 |
Y [mole frac)

Select the plot and from the Edit menu, click Copy.
Click in an empty area of the process flowsheet.

From the Edit menu, click Paste.

a > D

Position and size the plot as needed.
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Block B1: \-"apo-r Composition Profiles

[ﬂ —— TOLUEME

—————PHEMOL
= @Z ——————MCH

Stage

o—1]

0 01 0z 03 0.4 05 06 07 0.6 09 1
¥ (mole frac)

< I ;lj

F Mixers/Splitters | Separators Heat Exchangers Columnz | Reactors Pressure Changers Maripulatars I Sal 4 I 4
Material T sazmn T LT T =T T ’

STREAMS Mixer FSplit 5Split

|For Help, press F1 NUM Results Available 2

Example of Pasting a Plot into Another Application

In this example, the plot copied in the previous example will be pasted into a
Word document.

1. First, use the Plot Wizard to generate the plot of composition profiles, and
format it as you wish. See Chapter 13 for details on generating plots.

Select the plot, then from the Edit menu, click Copy.
Start Word, and open the file in which you want to paste the plot.

Click in the Word document where you want to paste the plot.

o~ N

From the Edit menu, click Paste.
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Example of Pasting Images From Other Windows Applications Onto the
Aspen Plus Process Flowsheet

In this example, an Excel graph will be placed onto the Aspen Plus process
flowsheet.

1. First, generate the desired graph or image in another application. In this
case, a pie chart is created in Excel.

2 Microsoft Excel - Pie Chart.xls M=l B3

xngiIe Edit Wiew Insert Format Tools Data ‘Window Help -|A ﬂ

DEE SRV & BB B = A5 ihd 3

Arial -0 B I U EEE=EE $%,fdg_,®.,£,
| al | =
A =] C D E F 5 H [ —
(N —
2| Standard Costs Per Pound of Product X
3
4 Cost Breakdown Per Pound
5 Raw Material A $0.65 Total = $1.51
G Raw Material B $0.44 -
7 Solent Loss $0.16 B Raw Material A
8 Utilities $0.05 B Faw Material B| |||
9 Labar 5012 O Solvent Loss
10 Wi'aste Disposal $0.06 O Uhtilities
11 W Lahor
12 Total 1.1 E'WWaste Disposal
13 -
[4[4[» [»i}Sheet1 Sheetz [ sheets / [4] | HIN
Ready MR

In Excel, select the graph, and from the Edit menu, click Copy.
Open the Aspen Plus simulation where you want to paste the Excel graph.
Click on an empty area of the process flowsheet.

From the Edit menu in Aspen Plus, click Paste.

L O

Move and resize the graph, and adjust the flowsheet view as necessary.

The Excel graph now appears on the process flowsheet.
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Creating Active Links Between
Aspen Plus and Other Windows
Applications

When copying and pasting information, you can create active links between input
or results fields in Aspen Plus and other applications such as Word and Excel. The
links update these applications as the process model is modified to automatically
propagate results of engineering changes.
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Creating Active Links Between an Aspen Plus Result
and another Windows Application

To create active links between a result in Aspen Plus and another Windows
application:

1. Make sure you have both applications open:

* Aspen Plus open with the completed simulation and results available

* Another Windows application open with the file where you wish to paste
the active link to Aspen Plus results

Open the Aspen Plus results form containing the information to be linked.

3. Select the desired results.
To select an individual field of data, simply click in the field.

To select multiple fields of data, hold down the Ctrl key while clicking the
mouse on multiple fields.

When copying values from a table, you can:

» Click-and-drag the mouse over a desired range of results
» Select an entire column of data by clicking the column heading
« Select an entire row of data by clicking the row selector button
» Select the entire table of data by clicking the button on the top left corner
of the table

4. From the Edit menu, click Copy (or Copy with Format). If you choose Copy
with Format, in the Copying dialog box, check the items you want included
with the value (Label, Units or Basis), and click OK.

5. Go to the appropriate location in another Windows application, where you
wish to paste the active link.

6. From the Edit menu in the other application, choose Paste Special.

7. In the Paste Special dialog box, click the Paste Link radio button and make
sure you are pasting as text by selecting Text in the As box:.

8. Click OK to close the Paste Special dialog box.
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Source: | o I
Az Cancel |
" Paste: Picture (Erhanced Metafile
¢ paste link:
| T Display as icon
~Result
Inserts the contents of the Clipboard as bext
ke withaut any Farmatking,
= Paste Link creates a link to the source file,
Zhanges to the source File will be reflected in
volr docurmenk,

Now an active link has been established between Aspen Plus (the source
document) and another application.

9. When you exit, be sure you save both the Aspen Plus file and the other
application file. If you do not, the link will not work when you open the files.
If you save the link source file (Aspen Plus in this case) with another name,
you must save the link container (other application file) after saving the
Aspen Plus run.
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Example of Creating Active Links from Aspen Plus Results into Excel

In this example, RadFrac condenser duty results will be copied with units, and
pasted into an Excel spreadsheet as an active link.

1. Open the RadFrac ResultsSummary Summary sheet to view the results for

condenser duty.

T emperature;
Chuaty:
Subcooled duty:
Ligquid flo:
Wapor flow:
Fefius ratic:

B oilup ratio:

— Caolumn performance

Summary I Balance I Split Fraction I Hebailer I

Condenizer / Rebailer /

Topstage  Bottom stage

216923738 [325127565 [F -]
24175242 [316133701 [Brushe =]
1600 1400 bmolsbe =]
0 1601.42987 [bmolthe =]
5

|1 143575348

On the Summary sheet, click the result value for condenser duty.

From the Edit menu, click Copy with Format.

In the Copying dialog box, check the Unit checkbox, then click OK.

Copying...

v Walue

[ Basis

]|

5. Open the Excel spreadsheet, and select the cell where you want to create the
link to the Aspen Plus results for condenser duty.
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2 Microsoft Excel - Book2 M=l E3
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6. From the Edit menu in Excel, choose Paste Special.
7. In the Paste Special dialog box, click the Paste Link radio button.
8. Select Text in the As: list, and click OK.

The condenser duty and units are copied into the specified location.

X Microsoft Excel - Book2 M=l 3

”E File Edit Wiew Insert Format Tools Data ‘'Window Help I =0

D aRY sB2BS o-- A®(zs8lillBes 2

| ara w0 - BIUSEE=EE$ %, B8 DA

] j =|{=s‘3\pwn.DDcument.1D.Dl'D:\mm1D\}{mp\mch.hkp'l'!OLE_LINK1!&5'}
A | B | € [ o [ E [ F [ & [ A [ 1 =

1 1=

| 2  Selected results from ASPEN PLUS simulation of MCH column

3

| 4

|5

| B

| 7

| § | Qutput

| 9 |Condenser Duty -2 4E+07 [T o

10

(11

(12

13 g

4 4]» [M]\Sheet1 { Shestz f Shests / 4] il JJ

Feady | T Sum=-24175241.5 | [ | =
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The pasted value is an active link between Aspen Plus (the source document) and
the Excel spreadsheet (the destination document.) As inputs are changed in the
Aspen Plus model, and the simulation is rerun to generate new results, the active
link displayed in the Excel spreadsheet will reflect the changes.

You can review the source of the link in Excel by selecting the linked cell in
Excel. The source will display in the Excel Formula Bar below the toolbar.

You can view and modify the status of the link in Excel by selecting Links from
the Edit menu.

Creating Active Links from a Windows Application to
Aspen Plus Input Fields

In addition to creating active links from Aspen Plus to other applications, you
can also create active links from other applications such as Word or Excel, to
input fields within Aspen Plus simulations. This can be used to create a simple
interface to your simulation models for non Aspen Plus users (e.g. operators or
other engineers.)

1. Make sure you have:

» Aspen Plus open at the completed simulation where you will add the
active link
* Another Windows application open at the source file from where you will
originate the active link to an Aspen Plus input field
2. In the source file of the other application, select the information to be linked.
For example, in Excel, click in the cell containing the data to be linked.

From the Edit menu in the other application, click Copy.

In Aspen Plus, open the appropriate input form, and select the field where
the information will be pasted to create the active link.

5. From the Edit menu in Aspen Plus, click Paste Special.

6. In the Paste Special dialog box, click the Paste Link button and ensure you
are pasting as text by selecting Text in the As list.

7. Click OK to close the Paste Special dialog box.

Now an active link has been established between another application (the
source document) and Aspen Plus (the destination document); if you change a
value in the source document, the change will be reflected on the appropriate
Aspen Plus input forms.

Aspen Plus User Guide 37-21
Version 10.1-0



37-22

Working with
Other
Windows
Programs

8. When you exit, ensure you save both the Aspen Plus file and the other

application file. If you do not, the link will not work when you open the files.
If you save the link source (the other application in this case) with a different

file name, you must save the link container (Aspen Plus) after saving the
other application file.

Example of Creating a Link from Excel to an Aspen Plus Input Field

In this example, an active link will be established from Excel that controls the
reflux ratio of a column in Aspen Plus.

1. Open the Excel spreadsheet to display the data from where you will establish

the link (the source file.)

2. Select the cell containing the information that will be linked.

2 Microsoft Excel - Book2 M=l E3
”ﬂ File Edit “iew Insert Format Tools Data Window Help & x|
DR sRy smRrd v-o- | Q® =A% Bed T
| aril -0 - BIUSEE=EE$%, 98 -d-A-

6 | = 3

A | B | e | o | E | F | 6 [ H [ T [T
i 1=
| 2 |Selected input from ASPEN PLUS simulation of MCH celumn
3
| 4
| 5 |Input
| 6 |Molar RR [ 8_'
7
EN
ER .
10
11
12
13 .
14 [ 4]» [pi]\Sheet1 { shestz / Sheets / |1] o J—l

Ready

[

MU |

T

3. From the Edit menu in Excel, click Copy.

4.

In the Aspen Plus simulation, open the RadFrac Setup Configuration sheet,
and select the field for the value of Reflux Ratio.

Aspen Plus User Guide
Version 10.1-0



Chapter 37

v"Eunfiguratiunl  Shreams | o F'ressurel v Condenzer | Fefaien | " EREE |

— Setup options

MHumber of stages: 22

Candenzer: Tatal j
Rebailer: Fettle j
Yalid phazes: Y apor-Liguid j
Canvergence: Standard j

— Operating specifications
Distillate rate =] |mae  =]]200 Ibmolhr =]

R eflus ratio j Mole j _ j
Eree waten rerlus ratio: I [E opfiors |

5. From the Edit menu in Aspen Plus, click Paste Special.

6. In the Paste Special dialog box, click the Paste Link radio button and make
sure you are pasting as text by selecting Text in the As list.

Pazte Special Ed |

Source: Sheet1IREC3 | OK |

Cancel |

" Paste

¥ Paste Link

Reszult
Inzerts the contents of the clipboard into your

_'@ docurment s Text. The data iz linked to the
gource file so that changes to the file will be
reflected in your document.

7. Click OK to close the Paste Special dialog box.

The reflux ratio displayed on the RadFrac Setup Configuration sheet is now
an active link to the source cell in the Excel spreadsheet. Any changes made
to the linked cell in the Excel spreadsheet will automatically be reflected in
the simulation input.

To illustrate the effect of the active link established in this example:

1. Open the Excel spreadsheet, and change the reflux ratio in the linked cell
from 8 to 10.
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2. Open the RadFrac Setup Configuration sheet again, and note that the value

for reflux ratio has been automatically changed.

Saving and Opening Files with Active

Links

If you create active links between Aspen Plus and other Windows programs, you
must follow a few rules to ensure that the links continue to work when you save
files and open them again. You should understand the following terms:

The link source is the program that is providing the data.
The link container is the program into which you paste the link.

For example, if you copy data from Aspen Plus and use Paste Special to paste a
link into Excel, Aspen Plus is the link source and Excel is the link container.

Saving Files with Active Links

When you save files with active links:

Be sure to save both the link source file and the link container file. If you do
not, the link will not be there when you open the files again.

If you save the link source with a different name (for example, using Save
As), you must save the link container after saving the link source. This is
because the link container contains the file name of the link source.

If you have active links in both directions between the two applications and
you change the name of both files, you must do three Save operations:

— Save the first application with a new name

— Save the second application with a new name

- Save the first application again

For example, if you have links in both directions between Aspen Plus and
Excel:

— Use Save As in Aspen Plus to save the run as MYRUN
— Go to Excel and use Save As
— Return to Aspen Plus and Save

Note: Links are saved when you save in Aspen Plus Document format (.apw) or
Aspen Plus Backup format (.bkp).
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Opening Files with Active Links

When you open the link source file, there is nothing special that you need do.

When you open the link container file, you will usually see a dialog box asking
you if you want to re-establish the links. Applications will behave differently or
may show different dialog boxes.

Microsoft Excel
@ Thiz document containg links. Fe-establish links?
Mo | Help |

If you:

Click Then And

No The link will not be active Any changes you make in the link source will not be

reflected in the link container.

Yes Windows will re-establish the link and open the You will not see the application on the Windows taskbar.
link source application in background. Thatis, the ~ You might notice a pause as Windows activates the
application will be open and running, but there application.

will be no visible windows for the application.

In some cases, when the link source is running in background, you might want to
make the application visible (have its windows displayed) so that you can make
changes.

For example, you may be using Excel (as link source) to supply feed stream data
to an Aspen Plus simulation (the link container). Normally, you can just open
Aspen Plus, re-establish the links, and run the simulation. But if you want to
change the feed stream data or add links to a another piece of data in the Excel
spreadsheet, you need to make Excel visible.

The method to make the link source application visible depends on the
application:

» For some applications, for example Aspen Plus and Microsoft Word, you can
open the file in the normal way using Open from the File menu or double-
clicking the file in Windows Explorer.

» For other applications, like Excel, if you try to open the file in the normal
way, you will receive a message that the file is locked or in use by another
user. If you proceed and open the file, you are actually working on another
copy of the document and links will not work properly.
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Because of problems with some applications, follow this procedure to make the
link source application visible:

1. From the Edit menu in the link container application, select Links.

The Links dialog box appears.

Links EHE |
Source File [tern Type Statuz | 0k I
entpidiutliz. apw QLE LIMK. Blocks BE.Inp Apwn.D.. ;
Cloze |
Update Mow |
Open Source |
ﬂ LChange Source. . |

Source File:c:vazpentpfdiutliz. apw
Item: OLE_LIME. Elocks BEInput MSTAGE!T
Type: ASPEM PLIS Docurment
Lpdate: % Automatic = Manual

2. In the Links dialog box, select the source file and click Open Source.

Now the link source application is visible. The application will appear on the
Windows taskbar.

Updating References in Excel

Microsoft Excel has an option which you must use to ensure that links are
correctly re-established when you open files with active links. To check the
option:

1. In Excel, from the Tools menu, click Options.

2. In the Options dialog box, click the Calculations tab.

3. Ensure the Update Remote References checkbox is selected.
There is also an option to Save External Link Values. This controls the

behavior of Excel when you have links but do not re-establish them when you
open the file or the links become broken.

If this option is Excel will display
Selected The last value it had before the link was broken
Clear An error

Aspen Plus User Guide
Version 10.1-0



Chapter 37

Using Embedded Objects in the Process
Flowsheet Window

You can embed other applications as objects in the Process Flowsheet window.

For example, you can embed a Word document or an Excel spreadsheet into the
Process Flowsheet window. There are two ways you can do this:

* Using Copy and Paste
* Using the Insert dialog box

Embedding an Object Using Copy and Paste

To embed an object using Copy and Paste:

1. In the source application, select the data, text, or other object you want to
embed.

2. From the Edit menu of the source application, click Copy.

3. Go to Aspen Plus and make sure that the Process Flowsheet Window is the
current window:

If you are using You should

Workbook mode Click the Process Flowsheet tab
Flowsheet as Wallpaper Click the flowsheet in the background
Normal View Select the Process Flowsheet window

4. In Aspen Plus, from the Edit menu, click Paste.

Embedding an Object Using the Insert Object Dialog
Box

To embed an object using the Insert Object dialog box:

1. In Aspen Plus, ensure that the Process Flowsheet Window is the current
window.

2. From the Edit menu, point to Insert, then New Object.
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3. To embed a new object, click Create New and in the Object Type list, select
the application or object.

To embed an object from an existing file, select Create From File and specify

the file.

Modifying an Embedded Object

You can modify an embedded object:

To

Do this

Edit the object using the
source application within
Aspen Plus

Double-click on the object.

—_ Or —_

1. Click the object to select it

2. Click the right mouse button.

3. On the popup-menu, point to ObjecttypeJr Object, then Edit.

The menus and toolbar in Aspen Plus are replaced with those of the
source application. You can edit the object. When you are done, click
anywhere in the Process Flowsheet Window to exit the application.

Activate the source
application to edit the object

1. Click the object to select it
2. Click the right mouse button.
3. On the popup-menu, point to ObjecttypeT Object, then Open.

The source application opens in another window. You can edit the object.

When you exit the application, the object is updated in Aspen Plus.

Move the object

1. Click the object to select it.

The mouse pointer becomes the move shape '%’

2. Click and hold the left mouse button while dragging the object
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To

Do this

Resize the object

1. Click the object to select it.

2. Move the mouse to the edge or corner of the object.

The mouse pointer becomes to the resize shape

3. Hold down the left mouse button and drag the cursor until the object is
the desired size.

Attach the object to a block

or stream in the flowsheet

1. Click the object to select it.

2. Click the right mouse button.

3. On the popup menu, click Attach.

4. Click the block or stream in the flowsheet.

The object is now attached to the selected block or stream. If the block or
stream is later moved to another location in the flowsheet, the image will
maintain its spatial arrangement with respect to the block.

+

Object type will depend on the source application

Saving a Run With an Embedded Object

Embedded objects are saved as part of a run only when you save in Aspen Plus
Document format (.apw files). When you save in Backup format (.bkp files), the
embedded object is not saved.

Aspen Plus User Guide
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38 Using the Aspen Plus
ActiveX Automation
Server

This chapter describes how to use the Aspen Plus ActiveX Automation Server.
The topics include:

e About the Automation server

» Viewing the properties and methods of Aspen Plus objects
e Objects exposed by the Automation server

e Using the Variable Explorer to navigate the tree structure
* Navigating the tree structure in the Automation interface
» Data values and Node attributes

¢ Physical quantities and Units of Measure

* Referencing non-scalar data

¢ Controlling a simulation problem

¢ Flowsheet connectivity and automation

* Members of Aspen Plus classes

This chapter assumes that you are familiar with Visual Basic and understand
the concepts of object-oriented programming.

The examples in this chapter use Visual Basic 5.0 and Visual Basic for
Applications (VBA) as the Automation Client. Examples are based on the pfdtut
example problem which is provided with the standard Aspen Plus installation as
a backup file named pfdtut.bkp. If you installed Aspen Plus in the default
location, this file is in Program Files\AspenTech\APUI100\xmp.

If you installed Aspen Plus in the default location, the Visual Basic examples in
this chapter are located in Program Files\AspenTech\APUI100\vbexample.
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About the Automation Server

The Aspen Plus Windows user interface is an ActiveX Automation Server. The
ActiveX technology (also called OLE Automation) enables an external Windows
application to interact with Aspen Plus through a programming interface using a
language such as Microsoft’s Visual Basic. The server exposes objects through the
COM object model.

With the Automation interface, you can:

» Connect both the inputs and the results of Aspen Plus simulations to other
applications such as design programs or databases.

» Write your own user interface to an Aspen Plus plant model. You can use this
interface to distribute your plant model to others who can run the Aspen Plus
model without learning to use the Aspen Plus user interface.

Using the Automation Server

38-2

In order to use the Aspen Plus Automation Server, you must:

» Have Aspen Plus installed on your PC
» Be licensed to use Aspen Plus

The type library for the server is happ.tlb, located in the Aspen Plus user
interface system directory. If you installed Aspen Plus in the default directory,
this will be Program Files\AspenTech\AP100UI\xeq. The server is an out-of-
process server, apwn.exe.

Before you can access the Aspen Plus type library from Visual Basic, in the
Visual Basic Project References dialog box, you must check the Aspen Plus GUI
10.0 Type Library box.

Before you can access the Aspen Plus type library from Excel VBA, in the Excel
Tools>References dialog box, you must check the Aspen Plus GUI 10.0 Type
Library box.

If Aspen Plus GUI 10.0 Type Library does not exist in the list, click Browse and
find the Aspen Plus User Interface system directory. Select happ.tib.

Error Handling

Errors may occur in calling methods or accessing properties of the Aspen Plus
objects. It is important to create an error handler for all code which accesses an
automation interface. An automation interface may return a dispatch error for
many reasons, most of which do not indicate fatal or even serious errors.
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Unless there is an error handler in place any error will normally cause a dialog
box to be displayed on the user’s screen. In VB the error handler is in the form of
an On Error statement, e.g. On Error Goto <line>. It is usual to create an error
handling subroutine which will tidy up and exit the application cleanly if any
severe errors are encountered.

Viewing the Properties and Methods of
Aspen Plus Objects

The properties and methods of the Aspen Plus objects may be viewed in the
Automation Client Object Browser:

In Visual Basic 5 and Excel, from the View menu, click Object Browser.
In Excel, the Module sheet must be active for this menu item to be present.

Most of the properties of Aspen Plus objects may be set through the Automation
interface to modify the simulation problem. However some properties of
simulation objects are read-only. If a property is read-only this is shown in the
VB Object Browser, but not in the Excel VBA Object Browser.

Objects Exposed by Aspen Plus

The object exposed by Aspen Plus is the IHapp object. An Object Browser may
show the class Happ in the place of IHapp. IHapp is the only object type that the
class Happ supports. An Aspen Plus application object should be declared as an
IHapp object not as a Happ object. Through this object, the other objects and
their properties and methods may be accessed.

The objects exposed by Aspen Plus are as follows:

Object Description
IHapp The Aspen Plus client object
IHNode The Aspen Plus problem input and results data are exposed as a tree structure composed of
IHNode objects
IHNodeCol Each IHNode object may own other nodes, and these are organized in an IHNodeCol
collection object
IHAPENgine This object provides an interface to the Aspen Plus simulation engine
Aspen Plus User Guide 38-3
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The IHapp Object

The IHapp object is the principal object exposed by Aspen Plus. This object
provides methods and properties such as:

e Opening a simulation problem
» Controlling the visibility of the Aspen Plus GUI
e Saving a problem

Example of Opening A Simulation

The following VB example obtains the simulation object for an existing simulation problem
stored in the backup file pfdtut.bkp, and sets the Visible property to display the Aspen Plus
graphical user interface.

Function OpenSimulation() As IHApp

Dim ihAPSIim As IHApp

On Error GoTo ErrorHandler

' open existing simulation

Set ihAPSIim = GetObject("C:\Program
Files\AspenTech\Apuil00\xmp\pfdtut.bkp™)
" display the GUI

ihAPSim.Visible = True

Set OpenSimulation = ihAPSIim

Exit Function

ErrorHandler:

MsgBox "OpenSimulation raised error " & Err & ": " & Error(Err)
End

End Function

The effect of the GetObject reference is to create a process running the Apwn.exe object
server. Any references to the same problem file from the same or other processes will connect
to the same running instance of the Apwn server.

The Aspen Plus Tree Structure

38-4

The input and results data in an Aspen Plus simulation problem are organized in
a tree structure.

In order to access the data of interest in an Aspen Plus simulation, you need to
understand and navigate through the tree structure and locate and identify the
variables of interest. To do this, you can use the Variable Explorer in the
Aspen Plus User Interface.
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Using the Variable Explorer to Navigate
the Tree Structure

Use the Variable Explorer to view and access variables associated with your
simulation. The Variable Explorer displays the attributes of each variable in the
simulation in a similar way to the Data Browser.

To open the Variable Explorer:

N

From the Tools menu, click Variable Explorer.

&£ B1
&£ B2
&£ B3
e B4
&£ B5
&0 BR

B R

-
-
-
-
-

W Variable Explorer

& Blocks j‘ Path to Mode

Application. Tree.Data. Blocks. BB Input BASIS_RR

Input

-3 Unit Set

[ ABSORBER
- [F ALGORITHM
B EF

-3 BASE_COMPS

£3 BASE_PHASE
£3 BASE_PROPERT
£ BASE_STAGE
£ BASE_STRMS_F
£ BASE_STRMS_P

[ BASIS_B

B BASIS_BR

-1 BASIS_CSFLOW
B BASIS_D

B BASIS_L1

B BASIS_RDY

--[& BASIS_RR =

M=l E3

Dimenzian ||:| — Meta-data Attrivtes for Records —  — Attributes for Mult-dimensioned —
Record NOATTR ariables
—Walue Related Attibutes Tae Fiart ID—
alue |1 2 Completion INDATTH Scrolled
Status Fair
Physical o
Quantity I — Attributes for Variable Hodes—— [~ Flowsheet Connectivity Part——
Unit of ID— Bt IU— Attributes
Measure InorOut [NOATTR
Basis MOLE Enterable |1 Gender  [NOATTR
ion Li u Lirnit | .
Option List INDATTH PRer LImi 10000000000 Mulipat  [NOATTR
Options [ 1] Lower Linit [§ fon000000a000
Part Type |NEIMTFI
Default l—
Value 1E+35
Prompt
Reflu ratio [Reflux u| | [ Other Attributes
rate/Distillate rate] which H
excludes free water for =B INDATTH
all loazes except wh Children
LI pt when LI

The Variable Explorer displays a tree view similar to the Data Browser. The
difference is that the Data Browser displays the variables conveniently grouped
and laid out on forms with prompt text, scrolling controls, selection boxes and
fields for data entry. The Variable Explorer exposes the underlying variables
within the simulation problem.

The Variable Explorer is important to the Automation user because it shows the
names and the structure of the variables which may be accessed through the
Automation interface.

Note The Variable Explorer is read-only. You cannot use the Variable Explorer
to change values or other attributes of variables.
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Note If you navigate through the tree structure in the Variable Explorer, it is
possible to create new objects which you may not be able to delete. For this
reason, you should save your Aspen Plus run before using the Variable Explorer
and not save it after you use the Variable Explorer.

Example of Using the Variable Explorer

This example gives instructions for using the Variable Explorer to access data in
the RadFrac block (Block B6) in pfdtut.bkp.

1.

8.
9.

From the Tools menu, click Variable Explorer to open the Variable Explorer.

The tree view on the left displays just the node labeled Root.

Double-click on the Root folder icon or click on the + icon to display the nodes
immediately below this: Data, Unit Table and Settings.

Expand Data to display the next level of nodes: Setup through to Results
Summary.

Expand the Blocks icon to reveal a list of blocks on the flowsheet: B1 through
B6.

Expand B6 to display nodes labeled Input through to Work Results.
Expand Input to display a list of nodes labeled Unit Set through to Y_EST.

These nodes represent the simulation input data for the RadFrac block. For
example, below the Input node, the node labeled NSTAGE holds the input
value for the number of stages in the column.

Click on the Output node to display a list of nodes labeled Unit Set through
Y_MS.

These nodes represent the output data for the RadFrac block. For example,
below the Output node, the node labeled BU_RATIO holds the result value for
the boilup ratio.

The Path to Node field of the Variable Explorer displays the path to the node
which is currently open. From this field, you can copy and paste directly into
your program. To do this, complete these steps:

Select the text in the Path to Node field, then click the right mouse button.

From the menu that appears, click Copy.

10. Go to your application (for example, Visual Basic or the Excel Module sheet).

11. From the Edit menu, click Paste.
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Navigating the Tree Structure In the
Automation Interface

The tree structure observed in the Data Browser is reflected in the Automation
interface.

The objects in an Aspen Plus simulation are exposed as a tree structure of
IHNode node objects. The root node of the tree is obtained by the Tree property of
IHapp.

Each IHNode object may have zero or more offspring IHNode objects. Each
IHNode object has a Dimension property which determines how the offspring
nodes are organized. A leaf node (i.e. one with no offspring) has a Dimension of
zero.

The offspring nodes of a node object may be obtained as a collection object,
IHNodeCol from the Elements property of an IHNode object.

To illustrate this, consider the following example:

Sub GetCollectionExample(ihAPsim As IHAPP)
' This example illustrates use of a collection object
Dim ihRoot As ihNode
Dim ihcolOffspring As IHNodeCol
Dim ihOffspring As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
‘get the root of the tree
Set ihRoot = ihAPsim.Tree
‘now get the collection of nodes immediately below the Root
Set ihcolOffspring = ihRoot.Elements
For Each ihOffspring In ihcolOffspring
strOut = strOut & Chr(13) & ihOffspring.Name
Next
MsgBox "Offspring nodes are: " & strOut, , "GetCollectionExample"
Exit Sub
ErrorHandler:
MsgBox "GetCollectionExample raised error" & Err & ": " & Error(Err)
End Sub

The collection object ihcolOffspring contains the collection of nodes immediately
below the root, i.e. those nodes with the labels Data, Unit Table and Settings as
observed in the Variable Explorer.

Aspen Plus User Guide 38-7
Version 10.1-0



Using the
ActiveX
Automation
Server

Nodes within each collection object may be accessed in one of two ways:

* You can iterate through the collection object using a For Each ... Next
structure, accessing each node in turn.

* You can access a node explicitly using the Item property of the IHNodeCol
object. In order to identify a particular item in a collection, the Item property
takes one or more arguments. Each argument is either a string specifying the
label or item name of an offspring node in the next level of the tree, or an
integer specifying the ordinal number of the node in the collection of offspring
nodes. The number of arguments required to the Item property is given by the
Dimension property of the parent.

Thus:
For Each ihOffspring In ihcolOffspring

Next

iterates through each node in the ihcolOffspring collection, and

Set ihDataNode = ihcolOffspring.ltem("Data")

obtains the node with the label “Data”. Note that the item names are case
sensitive.

The Dimension property determines the number of arguments required:

if ihcolOffspring.Dimension = 1 then

Set ihDataNode = ihcolOffspring.ltem("Data")
else if ihcolOffspring.Dimension = 2 then

Set ihDataNode = ihcolOffspring.ltem("Data","id2")
endif

The Item property is the default property of IHNodeCol, so this statement may
be abbreviated simply by writing:

Set ihDataNode = ihcolOffspring(“Data”)

Dot Notation for Navigating the Tree

38-8

To navigate down the tree you can chain the Item property references together.
For example, to get to the node labeled NSTAGE which represents the number of
stages in a RadFrac block:

Set ihNStageNode = ihAPsim.Elements("Data"). _
Elements("Blocks").Elements("B6"). _
Elements("Input").Elements("NSTAGE")
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A more concise notation is also available to navigate down the tree. This simply
allows the item names to be chained together, without specifying either the
Elements or the Item properties. For example, the above assignment may be
written:

Set ihNStageNode = ihAPSim.Tree.Data.Blocks.B6.Input. NSTAGE

However, although this ‘dot’ notation is convenient in many situations it has
some restrictions:

« It will only work if the item names are consistent with the syntax of an
identifier within the language used by the automation client, in this example
Visual Basic. So the item name must not contain embedded spaces or special
characters. For example the item name "Unit Table" would be invalid in this
notation.

» Certain node types do not support the dot notation. The node types that do
not support dot notation are connection, port, setting table, route, label, &
unit table.

Data Values

Once you have the leaf node containing the data value of interest, you can obtain
the data value associated with the node from the Value property. Data values have
an associated data type which is held in the ValueType property.

ValueType returns one of the following:

ValueType Description Visual Basic Data Type
0 Value not defined

1 Integer Long

2 Real Double

3 String String

4 Node I[HNode

Aspen Plus returns 32bit integer and 64bit real values. Therefore when using
Visual Basic, integer and real valued properties should be assigned to Long and
Double variables respectively in order to avoid potential overflow errors.
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Example of Accessing Data Values

Navigate to and display the number of stages in a RadFrac column (an input data value) and
the boilup ratio (a results data value) in a message box.

Sub GetScalarValuesExample(ihAPsim As IHAPP)
' This example retrieves scalar variables from a block
Dim ihColumn As ihNode
Dim nStages As Long
Dim buratio As Double
On Error GoTo ErrorHandler
' navigate the tree to the RADFRAC block
Set ihColumn = ihAPsim.Tree.Data.Blocks.B6
' Get the number of stages
nStages = ihColumn.Input.Elements("NSTAGE").Value
' get the boilup ratio
buratio = ihColumn.Output.Elements("BU_RATIO").Value
MsgBox "Number of Stages is: " & nStages _
& Chr(13) & "Boilup Ratio is: " & buratio, ,
"GetScalarValuesExample"
Exit Sub
ErrorHandler:
MsgBox "GetScalarValuesExample raised error" & Err & ": " &
Error(Err)
End Sub

Node Attributes

38-10

You can obtain information called attributes about the node from the
AttributeValue and AttributeType properties. These take an attribute
number argument which is an enumerated value from the
HAPAttributeNumber class.

These tables show some commonly used attributes and their descriptions.
The Attribute Name corresponds to the field in the Variable Explorer.

You can see the full range of possible values and descriptions in the Object
Browser of your Automation client (e.g., VB5). In general, you will only need a
small subset of the attributes.

Each node typically only supports a subset of the attributes. You can check
whether an attribute is supported by querying the AttributeType for the
attribute. The attribute types returned are as shown above for ValueType. If the
AttributeType property returns a value of zero for an attribute then the attribute
is not defined for that node.
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Attribute Name HAP_AttributeNumber Description

Value HAP_VALUE The current value

Physical Quantity HAP_UNITROW The row in the Unit Table for the physical quantity
of the value

Units of Measure HAP_UNITCOL The column in the Unit Table for the physical
quantity of the value

Basis HAP_BASIS The basis e.g. MOLE or MASS for a value

Option List HAP_OPTIONLIST A node whose offspring contain the valid values for

this node

Meta-data Attributes for Records

Attribute Name HAP_AttributeNumber Description

Record Type HAP_RECORDTYPE If the node is record structured, e.g. a block or a
stream, this property is a string containing the
record type, e.g RADFRAC for a RADFRAC
block and MATERIAL for a material stream.

Completion HAP_COMPSTATUS Returns an integer code giving completion

Status status. Bit masks for interpretation are available

in the enum HAPCompStatusCode.

Attributes for Variable Nodes

Attribute Name HAP_AttributeNumber Description

Output HAP_OUTVAR Is the variable node a results variable (read-only)
Enterable HAP_ENTERABLE Can the value attribute be modified?

Upper Limit HAP_UPPERLIMIT The upper limit on the value attribute.

Lower Limit HAP_LOWERLIMIT The lower limit on the value attribute.

Default Value HAP_VALUEDEFAULT The default value for the value attribute.

Prompt HAP_PROMPT A descriptive prompt for the node.

Attributes for Multi-dimensioned Variables Nodes

Attribute Name HAP_AttributeNumber

Description

First Scrolled Pair HAP_FIRSTPAIR

If the variable uses paired scrolling, the 1 based
index of the first item of the pair.
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Flowsheet Connectivity Port Attributes

Attribute Name HAP_AttributeNumber Description

In or Out HAP_INOUT Is the port node an inlet or outlet?

For blocks
0=lInlet
1=0Outlet

For Streams:
0=Outlet
1=Inlet

Gender HAP_PORTSEX Block or Stream port type:
0 = Stream
1=Block

Multiport HAP_MULTIPORT Can the port node be connected to
multiple streams?
0=No
1=Yes

Port Type HAP_PORTTYPE The type of the port node.
1 = Material
2 =Heat
3=Work

Other Attributes

Attribute Name HAP_AttributeNumber Description

Has Children HAP_HASCHILDREN Returns True if the node has offspring nodes.
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Example of Using AttributeValue

The following example subroutine uses AttributeValue to display a list of blocks showing the
block type, flowsheet section, and status for each block.

Sub ListBlocksExample(ihAPSIim As IHApp)

' This example ilustrates retrieving a list of blocks and their

attributes

Dim ihBlockList As IHNodeCol

Dim ihBlock As ihNode

Dim strOut As String

On Error GoTo ErrorHandler

Set ihBlockList = ihAPSim.Tree.Data.Blocks.Elements

strOut = "Block" & Chr(9) & "Block Type" _

& Chr(9) & "Section " & Chr(9) & "Results status"

For Each ihBlock In ihBlockList

strOut = strOut & Chr(13) & ihBlock.Name & Chr(9) & _
ihBlock.AttributeValue(HAP_RECORDTYPE) & " " & Chr(9) & _
ihBlock.AttributeValue(HAP_SECTION) & Chr(9) & _
Status(ihBlock.AttributeValue(HAP_COMPSTATUS))

Next ihBlock

MsgBox strOut, , "ListBlocksExample"

Exit Sub

ErrorHandler:

MsgBox "ListBlocksExample raised error" & Err & ": " & Error(Err)

End Sub

Function Status(CompStat As Integer) As String
' This function interprets a status variable and returns a string

If (CompStat And HAP_RESULTS_SUCCESS) = HAP_RESULTS SUCCESS) Then
Status = "Success"
Elself ((CompStat And HAP_RESULTS ERRORS) = HAP_RESULTS ERRORS) Then
Status = "Errors"
Elself ((CompStat And HAP_RESULTS WARNINGS) = HAP_RESULTS_WARNINGS)
Then
Status = "Warnings"
Elself ((CompStat And HAP_NORESULTS) = HAP_NORESULTS) Then
Status = "No results"
Elself ((CompStat And HAP_RESULTS_INCOMPAT) = HAP_RESULTS_INCOMPAT)
Then
Status = "Incompatible with input”
Elself ((CompStat And HAP_RESULTS _INACCESS) = HAP_RESULTS_INACCESS)
Then
Status = "In access"
End If
End Function

This example displays the following message box.
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Block Block Type Section Resultz status
B1 HEATER GLOBAL Succesz
B2 RSTOIC GLOBAL Success
@ B3 FLASHZ GLOBAL Success
B4 FSPLIT GLOBAL Succesz
B5 FSPLIT GLOBAL Success
BE RADFRAC GLOBAL Success

Physical Quantities and Units of Measure

For a value which represents a physical quantity, there are two important
attributes:

» The physical quantity (for example, temperature or pressure)
» The units of measurement in which the physical quantity is expressed (for
example, degrees Kelvin or degrees Fahrenheit)

The following sections describe how to:

» Retrieve the physical quantity and the units for a value
e Convert a value to a different units of measurement
* Change the units in the Aspen Plus run

Retrieving Units of Measure

38-14

You can retrieve:

* Units of measure for a value as a string
* Physical quantity and units of measure as references to the Unit Table

Units of Measure as a String

The unit of measurement symbol for a value can be obtained from the
UnitString property.

Example of Using Units of Measure

The following subroutine uses the UnitString property to display the outlet pressure of a flash
block together with the unit of measurement.
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Sub UnitStringExample(ihAPSIim As IHApp)

' This example retrieves the units of measurement symbol for a

' variable

Dim ihPresNode As ihNode

On Error GoTo ErrorHandler

Set ihPresNode = ihAPSim.Tree.Data.Blocks.B3.Output.B_PRES

MsgBox "Flash pressure is: " & ihPresNode.Value & Chr(9) & _
ihPresNode.UnitString, , "UnitStringExample"

Exit Sub

ErrorHandler:

MsgBox "UnitStringExample raised error " & Err & ": " & Error(Err)

End Sub

Converting

Aspen Plus User Guide
Version 10.1-0

The Units Table

Physical guantities and the corresponding units of measurement are described in
Aspen Plus by references to a Unit Table. Sometimes it is convenient to use the
units table directly, instead of dealing with the UnitString of a particular value.

The unit table consists of rows representing physical quantities and columns
representing the units of measurement in which the quantities can be expressed.
The unit table is exposed in the automation interface below the root node as a
node labeled “Unit Table”. The elements in the collection below the Unit Table
node represent the rows of the table i.e. physical quantities. The labels of these
nodes are the names of the physical quantities. Below each physical quantity
node is a collection of nodes whose labels are strings representing the symbols of
the units of measurement in which the owning physical quantity may be
expressed.

For a node in the tree containing a physical value, the physical quantity, or Unit
Table row number, is obtained by reference to the property
AttributeValue(HAP_UNITROW). The unit of measurement symbol, or Unit
Table column number, is referenced by the property
AttributeValue(HAP_UNITCOL). Note that the attribute values are actual row
and column numbers and that when referencing the row numbers with the Unit
Table collections, you must subtract one from these values.

the Units of Measure for a Value

You can retrieve a value in a specific unit with the ValueForUnit property. The
ValueForUnit property takes two arguments, the desired unit row and the
desired unit column.
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Example of Converting Units of Measure

Retrieve the pressure of block B3, both in the units specified in the run (psi) and
in atm. atm is column 3 in the Unit Table.

Sub UnitsConversionExample(ihAPSim As IHApp)

' This example retrieves a value both in the display units and an alternative

Dim ihPres As ihNode

Dim nRow As Long

Dim nCol As Long

Dim strDisplayUnits As String

Dim strConvertedUnits As String

On Error GoTo ErrorHandler

Set ihPres = ihAPSim.Tree.Data.Blocks.B3.Output.B_PRES

' retrieve the attributes for the display units (psi)

nRow = ihPres.AttributeValue(HAP_UNITROW)

nCol = ihPres.AttributeValue(HAP_UNITCOL)

strDisplayUnits = UnitsString(ihAPSim, nRow, nCol)

'select the alternative unit table column (atm)

nCol =3

strConvertedUnits = UnitsString(ihAPSim, nRow, nCol)

MsgBox "Pressure in Display units: " & ihPres.Value & _
" " & strDisplayUnits & Chr$(13) & _
"Pressure in Converted units: " & _
ihPres.ValueForUnit(nRow, nCol) & " " & strConvertedUnits, _
, "UnitsConversionExample”

Exit Sub

ErrorHandler:

MsgBox "UnitsConversionExample raised error " & Err & ": " & Error(Err)

End Sub

Public Function UnitsString(ihAPSim As IHApp, nRow As Long, nCol As Long)

' This function returns the units of measurement symbol given

' the unit table row and column

On Error GoTo UnitsStringFailed

UnitsString = ihAPSim.Tree.Elements("Unit Table"). _

Elements(nRow - 1).Elements.Label(0, nCol - 1)

Exit Function

UnitsStringFailed:

UnitsString = ™"

End Function

Changing the Units of Measure for the Aspen Plus Run

38-16

You can use the HAP_UNITCOL attribute to directly change the units of
measurement in the Aspen Plus run.

Changing the HAP_UNITCOL attribute value has a different effect depending on
whether the value in an Input or Output value, as follows:

e Changing the HAP_UNITCOL attribute of an output value will convert the
retrieved output value into the selected unit of measurement. This is
equivalent to changing the units on a Results sheet in the Aspen Plus GUI.

» Changing the HAP_UNITCOL attribute for an input value node will change
the input specification units. It does not convert the value into the selected
unit of measurement. This is equivalent to changing the units on an Input
sheet in the Aspen Plus GUI.
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Example of Changing Units of Measure

Sub UnitsChangeExample(ihAPsim)
Dim ihPres As ihNode
On Error GoTo ErrorHandler
Set ihPres = ihAPsim.Tree.Data.Blocks.B3.0Output.B_PRES
MsgBox "Pressure in default units: " _
& ihPres.Value _
& Chr(9) & ihPres.UnitString
' change units of measure to bar
ihPres.AttributeValue(HAP_UNITCOL, True) =5
MsgBox "Pressure in selected units: " _
& ihPres.Value _
& Chr(9) & ihPres.UnitString
Exit Sub
ErrorHandler:
MsgBox "UnitsChangeExample raised error " & Err & ": " & Error(Err)
End Sub

Referencing Non-Scalar Variables in the
Automation Interface

Most of the data in a simulation problem is organized into arrays, lists or tables,
and therefore is contained in multi-valued variables.

Non-scalar data is accessed through the automation interface one value at a time
via the Value property of a leaf node. The organization of the nodes which yield
the values depends both upon on the number of identifiers required to identify
the value, and upon the context. For example:

* Avalue in a column temperature profile requires the variable name and one
additional identifier: the stage number.

e Avalue in a column composition profile requires the variable name and two
additional identifiers: the stage number and the component.

* A reaction coefficient within a reactor requires the variable name and three
additional identifiers: the reaction number, the component and the substream

Once a multi-valued variable node is located, selection of identifiers to reach the
required individual value involves traversing down the tree. In some cases a
single node traversal represents selection of a single identifier. In other cases
traversal of a node represents selection of more than one identifier. Each node
has the property Dimension. If the value of Dimension is > 0 then the node has
offspring. The value of the Dimension property for a node determines the number
of identifiers associated with an offspring of that node. Dimensions are
referenced by an offset; the first dimension number is zero and the last
dimension number is the value of the Dimension property minus one.
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Offspring nodes are obtained in one of two ways:

» Using an iterator to loop through the collection object. For example, using a

For Each loop in Visual Basic.

» Using the Item property of the collection object and specifying an argument
for each Dimension of the collection. The argument may be either:

* Aninteger Location (also known as RowNumber) which represents the
ordinal number within the dimension. The first Location in each
dimension is numbered zero.

» Astring Label which identifies the offspring node within in the
Dimension.

For each dimension you can obtain the number of valid locations or labels from
the RowCount property of the collection.

Accessing Variables With a Single Identifier: Column
Temperature Profile

The temperature profile in a RadFrac column is an example of a variable with a
single identifier. For the pfdtut simulation results, the temperature profile is
displayed in the Data Browser in tabular form under Blocks>B6>Profiles>TPFQ.

The same information is located in the Variable Explorer under the
Root>Data>Blocks>B6>Output>B_TEMP variable node. Under this node there
are fifteen leaf nodes labeled 1 through 15, corresponding to the temperatures on
the stages.
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The structure of the information is shown schematically below:

|Variab|e Name: B_TEMP|

|Identifier: Stage Number

O paenoe]

0

Example Showing How to Access Column Temperature Profile through
the Automation Interface

To obtain the B_TEMP variable node:

Set ihTVar =ihAPSim.Tree.Data.Blocks.B6.Output.B_ TEMP

Next, create a simple iteration loop to access the offspring nodes representing the
stages.
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For Each ihStage In ihTVar.Elements

Next ihStage

The identifier representing the stage number is retrieved by the Name property
of the stage node. The temperature value is retrieved from the Value property of
the stage node.

Sub TempProfExample(ihAPsim)
' This example retrieves values for a non-scalar variable with one identifier
Dim ihTVar As ihNode
Dim ihStage As ihNode
Dim strOut As String
On Error GoTo ErrorHandler
Set ihTVar = ihAPsim.Tree.Data.Blocks.B6.Output.B_ TEMP
strOut = ihTVar.Elements.DimensionName(0) & Chr(9) & ihTVar.Name
For Each ihStage In ihTVar.Elements
strOut = strOut & Chr(13) & ihStage.Name _
& Chr(9) & Format(inStage.Value, "###.00") _
& Chr(9) & ihStage.UnitString
Next ihStage
MsgBox strOut, , "TempProfExample”
Exit Sub
ErrorHandler:
MsgBox "TempProfExample raised error " & Err & ": " & Error(Err)

End Sub

T empProfE xample |
Stage B_TEMP
1 2155 F
2 791 F
3 JE.E0 F
4 3107 F
A 3182 F
G 51595 F
7 3197 F
g 333 F
q 39259 F
10 39527 F
11 9550 F
12 FEEZ2 F
13 9553 F
14 39553 F
15 3553 F

Accessing Variables with 2 Identifiers: Column
Composition Profile

The liquid composition profile for RadFrac is an example of a variable with two
identifiers. For the pfdtut simulation results, the variable X in the Variable
Explorer tree view is shown in this diagram.
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The first level of nodes below the variable X represents the stages in the column
and each node has the Name property set to the stage number. The second level
of nodes contains the nodes for each of the component compositions and the
Name property of these nodes is the component id. The Value property of the
second level node is the composition of the component in the stage represented by
the first level node. This is shown schematically below.

|Variab|e Name: X |

|First Identifier: Stage Number |

‘ ( ) |Sec0nd Identifier: Componedt
[0

b

The following code fragment illustrates how to retrieve the component
compositions from this structure. It contains two nested loops which iterate
through the levels to access the value nodes.
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Public Sub CompProfExample(ihAPsim As IHApp)

' This example retrieves values for a non-scalar variable with two

" identifiers

Dim ihTrayNode As ihNode

Dim ihXNode As ihNode

Dim ihCompNode As ihNode

Dim strOut As String

On Error GoTo ErrorHandler

Set ihXNode = ihAPsim.Tree.Data.Blocks.B6.Output.Elements("X")

For Each ihTrayNode In ihXNode.Elements

For Each ihCompNode In ihTrayNode.Elements
strOut = strOut & Chr(13) & ihTrayNode.Name &
Chr(9) & ihCompNode.Name & Chr(9) & _
ihCompNode.Value
Next ihCompNode

Next ihTrayNode

MsgBox strOut, , "CompProfExample”

Exit Sub

ErrorHandler:

MsgBox "CompProfExample raised error " & Err & ": " & Error(Err)

End Sub

Accessing Variables With 3 Identifiers: Reaction
Coefficients

38-22

The following diagram shows the Variable Explorer tree view for the the RStoic

reactor block B2 in the pfdtut simulation.

In the RStoic reactor model, the stochiometric coefficients of the reactions are
held in the input variables COEF and COEF1 which represent the reaction

coefficients for the reactants and products, respectively.
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Both these nodes have a list of offspring nodes, each of which represents a

reaction equation.

As this block has only one reaction, both COEF and COEF1 have just one
offspring node labeled “1” representing the single reaction with the reaction

number “1”.

Chapter 38

The reaction node has two dimensions so the Dimension property of this node
returns a value of 2. There are two identifiers associated with each offspring. The
identifier for the first dimension is the component of the reactant. The identifier
for the second dimension is the substream, in this case the MIXED substream.

38-23



38-24

Using the
ActiveX
Automation
Server

This structure is shown schematically in the following diagram.

Variable Name: COEFF

First identifier: Reaction Number |

Second Identifier:Component
Third Identifier: Substream

O [aseroe ]
—0

The reaction node is an example of a node which uses paired scrolling of
identifiers. Here the only significant offspring nodes are those with the same row
number in each dimension. The existence of paired scrolling may be determined
from the value of the property AttributeValue (HAP_FIRSTPAIR). If the node
uses paired scrolling of offspring, this property returns the 1-based index of the
first item of the scrolling pair.

The following example code shows how to retrieve the coefficients under the
COEF node together with the associated identifiers. Note that because paired
scrolling is used, only the nodes with the same value of location in each
dimension are accessed.
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Sub ReacCoeffExample(ihAPsim As IHApp)
' This example illustrates retrieving values for a non-scalar variable
' with three identifiers
Dim ihReacNode As ihNode
Dim ihCoeffNode As ihNode
Dim intOff As Long
Dim strHeading As String
Dim strTable As String
Dim nReacCoeff As Integer
On Error GoTo ErrorHandler
Set ihCoeffNode = ihAPsim.Tree.Data.Blocks.B2.Input. COEF
" loop through reaction nodes
For Each ihReacNode In ihCoeffNode.Elements
strHeading = ihCoeffNode.Elements.DimensionName(0) _
& Chr(9) & ihReacNode.Elements.DimensionName(0) _
& Chr(9) & ihReacNode.Elements.DimensionName(1)
nReacCoeff = ihReacNode.Elements.RowCount(0)
" loop through coefficient nodes retrieving component and substream
' identifiers and coefficient values
For intOff = 0 To nReacCoeff - 1
strTable = strTable & Chr(13) & ihReacNode.Name & Chr(9) _
& Chr(9) & ihReacNode.Elements.Label(0, intOff) & Chr(9) _
& Chr(9) & ihReacNode.Elements.Label(1, intOff) & Chr(9) _
& Chr(9) & ihReacNode.Elements.Iltem(intOff, intOff).Value
Next intOff
MsgBox strHeading & strTable, , "ReacCoeffExample"”
Next ihReacNode
Exit Sub
ErrorHandler:
MsgBox "ReacCoeffExample raised error " & Err & ": " & Error(Err)
End Sub

ReacCoeffExample

1 BZ MI=ED -1

@ REACHO STOIC-CID SUBSTREAM
1 H2 MI=ED -3

Flowsheet Connectivity and Automation

The connections between blocks and streams in the flowsheet may be accessed via
the Automation server.

Both block and stream nodes have Port and Connection nodes which hold
information about their ports and what is connected to the ports.

This code sample displays a table showing source and destination blocks and
ports for all streams in the flowsheet.
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Sub ConnectivityExample(ihAPsim As IHApp)
' This example displays a table showing flowsheet connectivity
Dim ihStreamList As ihNode

Dim ihBlockList As ihNode

Dim ihDestBlock As ihNode

Dim ihSourceBlock As ihNode

Dim ihStream As ihNode

Dim strHeading As String

Dim strTable As String

Dim strDestBlock As String

Dim strDestPort As String

Dim strSourceBlock As String

Dim strSourcePort As String

Dim strStreamName As String

Dim strStreamType As String

On Error GoTo ErrorHandler
Set ihStreamList = ihAPsim.Tree.Data.Streams
Set ihBlockList = ihAPsim.Tree.Data.Blocks

strHeading = "Stream" & Chr(9) & "From" _
& Chr(9) & Chr(9) & Chr(9) & "To" & Chr(13)

For Each ihStream In ihStreamList.Elements
strStreamName = ihStream.Name
strStreamType = ihStream.AttributeValue(HAP_RECORDTYPE)
' get the destination connections
Set ihDestBlock = ihStream.Elements("Ports").Elements("DEST")
If (ihDestBlock.Elements.RowCount(0) > 0) Then
"there is a destination port
strDestBlock = ihDestBlock.Elements(0).Value
strDestPort = ihBlockList.Elements(strDestBlock). _
Connections.Elements(strStreamName).Value
Else
"it's a flowsheet product
strDestBlock ="
strDestPort ="
End If
' get the source connections
Set ihSourceBlock = ihStream.Elements("Ports").Elements("SOURCE")
If (ihSourceBlock.Elements.RowCount(0) > 0) Then
"there is a source port
strSourceBlock = ihSourceBlock.Elements(0).Value
strSourcePort = ihBlockList.Elements(strSourceBlock). _
Connections.Elements(strStreamName).Value
Else
'it's a flowsheet feed
strSourceBlock ="
strSourcePort = "™
End If

strTable = strTable & Chr(13) & strStreamName _
& Chr(9) & strSourceBlock _
& Chr(9) & strSourcePort & Chr(9) _
& Chr(9) & strDestBlock & Chr(9) _
& strDestPort
Next ihStream
MsgBox strHeading & strTable, , "ConnectivityExample"
Exit Sub

ErrorHandler:
MsgBox "ConnectivityExample raised error" & Err & ": " & Error(Err)

End Sub
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2
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\i.) 5 B3 v([OUT)
B B3 L{OUT)
7 E5  P[OUT)
g BE  D[OUT
q EE  EB(OUT)

10 B4 F[OUT)
11 B4 P[OUT)
12 BE  F[OUT)
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To

Bl
Bl
B2
B3
B4
BS
BE

Bl
Bl

FlIM]
FlIM]
FlIM]
FlIM]
FlIM]
FlIM]
FlIM]

FlIN)
FlIN]

ion Client

The Engine property of a Happ object returns a IHAPENgine object, which is an

interface to the simulation engine. The Happ and IHAPENgine objects provide

methods to enable an Automation client program to run and control a simulation.

The following code fragment illustrates how a user is prompted for a simulation
parameter, the simulation is re-run and the updated results are displayed to the

user.
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Public Sub RunExample(ihAPsim As IHApp)
' This example changes a simulation parameter and re-runs the simulation
Dim ihEngine As IHAPENgine
Dim nStages As Variant
Dim strPrompt As String
On Error GoTo ErrorHandler
Set ihEngine = ihAPsim.Engine
EditSimulation:
nStages = ihAPsim.Tree.Data.Blocks.B6.Input.Elements("NSTAGE").Value
strPrompt = "Existing number of stages for column B6 =" & nStages _
& Chr(13) & "Enter new value for number of stages."
nStages = InputBox(strPrompt)
If (nStages = ") Then GoTo finish
" edit the simulation
ihAPsim.Tree.Data.Blocks.B6.Input.Elements("NSTAGE").Value = nStages
' run the simulation
ihAPsim.Run
" look at the status and results
Call ListBlocksExample(ihAPsim)
Call TempProfExample(ihAPsim)
GoTo EditSimulation
finish:
Exit Sub
ErrorHandler:
MsgBox "RunExample failed with error " & Err & Chr(13) & Error(Err)
End Sub

Members of Aspen Plus Classes

This section lists the members of each of the exposed Aspen Plus classes.

Members of Class IHApp

Standard VB Properties and Properties to Manipulate the Main Window

Name and Arguments Member Type  Read-only Description
Activate() Sub Activate the application
Application As Happ Property Yes Returns the application of the object
FullName As String Property Yes Returns the full name of the application
Name As String Property Yes Returns the name of the application
Parent As Happ Property Yes Returns the creator of the object
Visible As Boolean Property Returns the visible state of the application
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Properties to Access Other Parts of the Object Model

Name and Arguments Member Type  Read-only Description
Engine As IHAPENgine Property Yes Return the interface to the simulation engine
Tree As [HNode Property Yes Get top node of file

Basic File Operations

Name and Arguments Member Type  Read-only Description

Save() Sub Saves current file

SaveAs(filename As String, Sub Saves current file under new name

[overwrite])

Restore(filename As String) Property Yes Restores, or merges, an archive file into the current
problem

WriteArchive(filename As Sub Exports a archive file.

String)

Initialization Methods to be Used with CreateObject()

Name and Arguments Member Type  Read-only Description
InitFromArchive(filename As ~ Sub Opens an archive and initializes
String)

InitFromFile(filename As Sub Opens a file and initializes
String, [readonly])

InitFromTemplate (filename Sub Opens a template and initializes
As String)

InitNew([filename], Sub Initializes a new, untitled tree
[overwrite])

Basic Run Operations

Name and Arguments Member Type Read-only Description
Reinit() Sub Reinitialize the simulation case. To reinitialize specific
blocks or streams, use the Reinit member of the
IHAPENgine class.
Run() Sub Run the simulation case.
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Selection Buffer Operations Used to do Cut and Paste Strictly Via

Automation

Name and Arguments Member Type Read-only Description

DeleteSelection(Key As Sub Delete a selection buffer.

String)

NewSelection(Key As Function Create and return a new selection buffer.
String) As IHSelection

SaveSelection(Key As Sub Save a selection buffer.

String)

Selection(Key As String) As Property Yes Retrieve a selection buffer.

IHSelection

Members of Class IHNode

Standard VB Properties

Name and Arguments Member Type Read-only Description
Application As Happ Property Yes Returns the application of the object.
Parent As Happ Property Yes Returns the creator of the object.

Properties to Access Other Parts of the Object Model

Name and Arguments Member Type Read-only Description

Dimension As Long Property Yes Return the number of dimensions in the directory (0 for
scalar).

Elements As [HNodeCol Property Yes Return a collection object containing the node’s

offspring nodes
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Name and Arguments Member Type Read-only  Description
AttributeType (attrnumber Property Yes Get type of attribute for attrnum:
As Integer) As Integer 1=int

2=real

3=string

4=node

5=memory block

(see Enum HAPAttributeNumber for possible values).
AttributeValue (attrnumbe Property Get the value of the attribute for attrnum (see Enum
As Integer, [force]) HAPAttributeNumber for possible values).
HasAttribute (attrnumber As Property Yes Checks whether attribute is defined for attrnum (see
Integer) As Boolean HAPAttributeNumber for possible values).
SetValueAndUnit(Value, Sub Store the value attribute and the Unit of Measurement
unitcol As Integer, [force]) attribute of the object simultaneously.
SetValueUnitAndBasis Sub Store the value attribute, the Unit of Measurement attribute,
(Value, unitcol As Integer, and the basis for the object simultaneously.
basis As String, [force])
Value([force]) Property Get the value attribute of the object.
ValueForUnit(unitrow As Property Gets the value in the specified units.
Integer, unitcol As Integer)
ValueType As Integer Property Yes Get type of value attribute:

0=not defined

1=int

2=real

3=string

4=node

5=memory block
Helper Methods
Name and Arguments Member Type  Read-only Description
FindNode(path As String) Function Navigate to a different node.
As I[HNode
Name([force]) As String Property Returns the name of the object (force argument is

unused).

UnitString As String Property Yes Returns the unit of measurement symbol of the node

value as a string.
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Methods Used to Manipulate the Data

Name and Arguments Member Type  Read-only Description

Clear() Sub Clear contents of the node.
Delete() Sub Delete element.
RemoveAll() Sub Remove all elements.

Members of Class IHNodeCol

38-32

Standard VB Properties

Name and Arguments Member Type Read-only  Description
Application As Happ Property Yes Returns the application of the object.
Parent As Happ Property Yes Returns the creator of the object.

Main Navigation Method

Name and Arguments Member Type ~ Read-only ~ Description

Item(loc_or_name, Property Yes Given a set of indices or names, returns an element in the
[loc_or_name2], collection

[loc_or_name3],

[loc_or_name4],

[loc_or_name5]) As IHNode

Principal Data Manipulation Methods

Name and Arguments Member Type Read-only Description
Add(floc_or_name, Function Creates and adds a child of type:
[Ioc_or_nameZ], 1 =scalar
[loc_or_name3], 4 = list
[loc_or_named], 5 = named list, with value type of:
[loc_or_nameb]) As IHNode 0=not defined
1=int
2=real
3=string
4=node
5=memory block.
Insert(element As IHNode, Sub Inserts an element into collection.
[loc_or_name],
[loc_or_name2],
[loc_or_name3],
[loc_or_named],

[loc_or name5])
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Principal Data Manipulation Methods (Continued)

Name and Arguments Member Type Read-only Description

InsertRow(dimension As Sub Inserts a new row at location in the specified dimension, dim.
Long, location As Long)

Remove(loc_or_name, Function Removes an element.
[loc_or_name2],

[loc_or_name3],

[loc_or_name4],

[loc_or_name5]) As IHNode

RemoveRow(dimension As  Sub Removes a row at location in the specified dimension, dim.
Long, location As Long)

Important Properties About the Data

Name and Arguments Member Type  Read-only Description

Dimension As Long Property Yes Returns the number of dimensions in the directory.
Label(dimension As Long, Property Returns the row label for the specified row location in the
location As Long, [force]) As specified dimension (force argument is unused).

String

LabelLocation(Label As Property Yes Returns the location, or row number, of the label along the
String, dimension As Long) dimension, dim.

As Long

RowCount(dimension As Property Yes Returns the number of elements in the dimension.

Long) As Long

Other Properties About the Data

Name and Arguments Member Type Read-only Description

Count Property Yes Returns total number of object slots in collection.
DimensionName(dimension Property Yes Gets a display name for the given dimension for variable or
As Long) As String table.

LabelNode(dimension As Property Yes Returns a node for manipulating the label.

Long, location As Long,
[Label]) As IHNode

IsNamedDimension ([dim]) Property Yes Returns whether the rows for this dimension of the collection
As Boolean are named.
ItemName(location As Property Returns name or row hame for element at location (force
Long, [dim], [force]) As argument is unused).
String
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Other Properties About the Data (Continued)

Name and Arguments Member Type Read-only Description

LabelAttribute(dimension Property Returns the value of an attribute for the label in the row,

As Long, location As Long, location, along the dimension, dim, for attrnum (see

attrmum As Integer, [force]) HAPAttributeNumber for possible values), (force argument is
unused).

LabelAttributeType(dimensi Property Yes Returns the type of an attribute for the label in the row,

on As Long, location As
Long, attrnum As Integer)
As Integer

location, along the dimension, dim, for attrnum (see
HAPAttributeNumber for possible values).

Members of Class IHAPENgine

Basic Run Operations

Name and Arguments

Member Type Read-only

Description

MoveTo(object_type As Sub Move current simulation step to object or begining of
IAP_MOVETO_TYPE, sequence.

[object_id])

Reinit([object_type], Sub Reinitialize all or portion of simulation (if object_type is used it
[object_id]) must be an IAP_REINIT_TYPE.)

Run() Sub Run simulation problem.

Stop() Sub Stop simulation run.

Manipulate Stop Points

Name and Arguments Member Type ~ Read-only ~ Description

AddStopPoint(type As Sub Add a stop point, before_or_after:
IAP_STOPPOINT_TYPE, 1 = before

object _id As String, 2 = after.

before_or_after As Long)

ClearStopPaints() Sub Clear all stop points.

DeleteStopPoint(index As Sub Delete stop point based on 1-based index.

Long)

StopPointCount As Long Property Yes How many stop points are set?

GetStopPoint(index As Sub Retrieve information about a stop point, index: 1-based
Long, type As index of stop point before_or_after: 1 = before , 2 = after.

IAP_STOPPOINT_TYPE,
object _id As String,
before_or_after As Long)
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Manipulate the Client-Server Communications

Name and Arguments Member Type Read-only  Description

Host(host_type As Long, Function Connect to host specified by host_type (0-based index of
[node], [username], available host types).

[password],

[working_directory]) As

Boolean

HostCount As Long Property Yes Returns the number of host types available to connect to.
HostDescription (host_type Function Returns a description for the host type specifed by the

As Long) As String

host_type index (0-based).

Miscellaneous Option Settings

Name and Arguments Member Type Read-only  Description
EngineFilesSettings(file As Property Retrieve setting for engine files.
IAP_ENGINEFILES) As
String
OptionSettings(type As Property Retrieve setting for simulation run options.
IAP_RUN_OPTION) As
Boolean
g o 0O o
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39 Heat Exchanger Design
Program Interface

This chapter describes how to use the Aspen Plus heat exchanger design program
interface (HTXINT) to transfer heating/cooling curve data from an Aspen Plus
run to a heat exchanger design program.

The topics in this chapter include:

» Generating property data

* Starting HTXINT

e Selecting heating/cooling curve results
* Generating the interface file

e Using the interface in a design program
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About the Heat Exchanger Design
Program Interface

You can use the heat exchanger design program interface (HTXINT) to select
heating/cooling curve data from an Aspen Plus run and transfer it to a file in a
format that can be read by these heat exchanger design programs:

« B-JAC's HETRAN

« HTFS's TASC, ACOL, and APLE

e« HTFS's M-series programs, including M-TASC, M-ACOL, and M-APLE
» HTRI's ST, CST, ACE, PHE, and RKH

You can extend the default data produced by the heating/cooling curves to include
all of the properties each design program needs.

Run HTXINT after completing an Aspen Plus run and before starting the design
program. HTXINT guides you through a series of prompts. Select the
heating/cooling curves for the design program.

HTXINT is an application written using the Aspen Plus summary file toolkit. The
location of the FORTRAN source code for your computer is:

Version Location

OpenVMS ASP$TOOL

UNIX $ASPDIR/asptool
DOS Y%asptop%\TOOLKIT

Generating Property Data in a Simulation

39-2

HTXINT uses property data from heating/cooling curves that can be generated by
many Aspen Plus unit operation models. To use HTXINT, you must first use
Aspen Plus to generate the required heating/cooling curves. Create one or more
heating/cooling curves for each block of interest. For details on specifying heating
and cooling curves, see Volume 1, Chapter 14. On the Hcurve form for the block:

1. Specify HXDESIGN in the Property Sets field.

2. Select the required number of points. See Specifying the Number of
Heating/Cooling Curve Points, this chapter.

3. Specify the pressure drop.
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The following sections describe each step.

Specifying the Property Set

To generate the property data required for all supported heat exchanger program
interfaces, select the built-in property set HXDESIGN on the Hcurve forms.

Specifying the Number of Heating/Cooling Curve Points

The Aspen Plus default of ten intermediate points is generally acceptable. You
can increase or decrease this number. If the number of points exceeds the
maximum number that the heat exchanger program accepts, HTXINT selects the
points to include the end-points and any dew or bubble points in the
heating/cooling curve. Since Aspen Plus adds extra points for dew or bubble
points, more points may be generated than you request.

Specifying Pressure Drops

HETRAN is the only design program that accepts non-isobaric property curves. A
heating/cooling curve with a pressure drop cannot be copied to the interface files
for the other programs.

HTRI programs accept up to three curves per side at different pressures. For
maximum accuracy, define three heating/cooling curves for:

* Inlet pressure
e Outlet pressure
* Intermediate pressure where phase change occurs

Starting HTXINT

To run HTXINT interactively, select the appropriate command:

Version Command
OpenVMS HTXINT runid
UNIX htxint runid
DOS HTXINT runid
Where:

runid is the ID of the Aspen Plus run
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HTXINT reads the data from the summary file named runid.SUM (runid.sum on
UNIX systems). If runid.SUM does not exist, HTXINT reads the data from the
backup file named runid.BKP (runid.bkp on UNIX).

The program guides you with a series of prompts. To leave the HTXINT program
at any time, type EXIT or QUIT.

HTXINT asks for the name of the target design program:
Please enter the required interface. (BJAC, HTFS, M-HTFS or HTRI) >

Enter the vendor's name for the target design program:

Enter To write data for

BJAC HETRAN

HTFS TASC, ACOL, and APLE
M-HTFS M-TASC, M-ACOL, and M-APLE
HTRI ST, CST, ACE, PHE, and RKH

HTXINT prompts for the units of measure:

Please select the units to display the data. (SI, ENG or MET) >

Select the units to use for displaying the heating/cooling curve data on the screen.
The options are Aspen Plus units sets.

The B-JAC, HTFS, and HTRI interfaces use the vendor-specific units set closest
to the selected Aspen Plus units set, when writing data to the interface file.
Different vendors use slightly different combinations of units in their units of
measure. The interface uses the most appropriate one. See Using the Interface
File in your Heat Exchanger Design Program, this chapter, for a list of the
corresponding units of measurement. The M-HTFS interface is always written in
Sl units.

HTXINT prompts you for the name of the output file:

Please enter the output file name (Default is runid.ext) >>

The default output file is created in your default directory with the same filename
as the summary file. The extension depends on the target program. See Using the
Interface File in Your Heat Exchanger Design Program, this chapter, for
examples of the file extensions.

If you choose the name of a file that already exists, HTXINT asks if you want to
overwrite it or choose another filename.
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Selecting Heating/Cooling Curve Results

to Expor

t

To select the heating/cooling curve:
1. Enter the block ID.

2. Enter the heating/cooling curve number.

3. Choose whether to view or write the data for the heating/cooling curve.

When you complete Step 3, you are returned to Step 1. You can continue to select
and copy further heating/cooling curve data, up to the maximum number of
heating/cooling curves allowed by the heat exchanger design program.

The following sections describe each step.

Entering the Block ID

HTXINT lists on the screen all blocks that have heating/cooling curves. Enter a
block ID to display the list of heating/cooling curves for that block. For example,
the screen displays:

The following blocks have Hcurves.

+ +
| Block ID | Model type |
+ + +

| EO1 | HEATX

| TOl | RADFRAC |
+ + +

Please select a block ID from the list. >

Entering the Heating/Cooling Curve Number

Enter the heating/cooling curve number from the list of heating/cooling curves for
the block. The screen displays:

The Hcurves for block EO1 are as follows.

4

+
INUMBER|Side | Type |
[ . | (NSQM)
+

Pressure range | Temp. range | Vfrac range|

|

4 4

4 4
T T

|

+ t t

| 1 |HOT | HOT [0.410E+07 0.410E+07 [322.039 207.039|1.000 0.639 |
| 2

+

|[COLD |COLD 0.4

45E+07 0.445E+07 |183.150 200.656| 0.000 0.000]
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Please select an Hcurve from the list by entering its number. > 2

Viewing and Writing the Data for the Heating/Cooling
Curve

HTXINT asks:
Do you wish to view data points for this curve? (Y/N) >

If you enter N, the data for this heating/cooling curve is written to the interface
file.

If you enter Y to view the data, the heating/cooling curve points appear. For
example:

+ + + + +
TEMP | DUTY | PRES | VFRAC |
Ky | (WATT) | (N/SQM) | |

+ + + + +
322.039 | 0.31907E+04 | 0.41024E+07 | 1.000
317.775| -0.71198E+05 | 0.41024E+07 | 1.000
311.584 | -0.21327E+06 | 0.41024E+07 | 0.994
301.130 | -0.46122E+06 | 0.41024E+07 | 0.980
290.675 | -0.72166E+06 | 0.41024E+07 | 0.963
280.221 | -0.99223E+06 | 0.41024E+07 | 0.941
269.766 | -0.12693E+07 | 0.41024E+07 | 0.916
259.312 | -0.15503E+07 | 0.41024E+07 | 0.888
248.857 | -0.18344E+07 | 0.41024E+07 | 0.857
238.403 | -0.21230E+07 | 0.41024E+07 | 0.822
227.948 | -0.24205E+07 | 0.41024E+07 | 0.779
217.493 | -0.27370E+07 | 0.41024E+07 | 0.724
207.039 | -0.30963E+07 | 0.41024E+07 | 0.639

+ + + + +

Indicate whether you want to write the data for the heating/cooling curve by
responding to this prompt:

Do you want this Hcurve to be written to the interface file? (Y/N) >

If you enter Y, the heating/cooling curve data is written to the output file. If you
enter N, you can enter another heating/cooling curve number.

If the heating/cooling curve contains calculation errors, any points with errors are
indicated with an asterisk (*) and the following prompt appears:

Do you want data for the points with the calculation errors to be
suppressed? (Y/N) >

If you enter Y, the points with errors will be excluded.

Aspen Plus User Guide
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Generating the Interface File
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After you choose a heating/cooling curve to write to the interface file, HTXINT
provides prompts for descriptive data for the target design program. Examples of
information you may want to provide are a problem description, case name, and hot
or cold fluid name. HTXINT indicates when the number of characters you can use
is restricted, and validates your data entry.

HTXINT generates the input, then asks you if you want to select another
heating/cooling curve.

The following text shows an example of providing descriptive data for the HTRI
interface.

Please provide a one line description of the problem up to 70
characters.

> HCURVE DATA COPIED FROM HEAT EXCHANGER EO01
Please provide a one line case description of up to 70 characters.
> BASE CASE

Enter the cold fluid name. 12 characters maximum > C1

Data for curve has been written to the interface file.

Do you want to select another Hcurve? (Y/N) > N
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Using the Interface File in Your Heat
Exchanger Design Program

The interface program creates a file containing heating/cooling curve data. This
file includes the descriptive data you entered at the prompts. The file format,
name, and how the file is used depends on the design program. The input file that
HTXINT produces contains only heating/cooling curve data. It does not contain
the complete data necessary to run the design program.

Maximum Number Maximum Number
Design Interface Units of of Heating/Cooling of Heating/Cooling
Program Filename Measure’ Curves Curve Points How to Use
B-JAC filename.hji S, US, Hot side = 1 13 (inlet, outlet, dew Run B-JAC. Select Shell&Tube Heat
metric Coldside=1 point, bubble point, Exchanger Programs, then Thermal
and up to 9 others) Design, then Establish the Filename, then
Create or Modify Input File.
HTFS filename.dat S|, British, Hot side = 1 12 Edit and complete the data in the input file.
metric Cold side =1
HTFS M- filename_ps,fTJr Slonly Hot side = 1 12 Run DOS program. Select Input Data
Series Coldside=1 Editor. Then either create or edit input and
import the interface file, using function key
F5.
Or
Run Windows program. Select Import
Simulator Input File from File menu.
HTRI filename.dat SI, US, Hot side = 3 10 Edit and complete the data in the input file.
MKH Cold side =3 Or

Enter the program and select the input file.

t  These are the vendors' names for units of measurement sets that correspond approximately to the SI, ENG, and METRIC sets in

Aspen Plus.
tt  Use this file in the way described in this table. The format and units of a process simulator file are different from the usual HTFS
input file.
g o o 0
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